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Section 1 - Product Overview

System Requirements

To ensure your D-ViewCam system can maintain high video monitoring and recording performance, certain minimum system configurations are

required.
CPU Intel Core 2 Duo E5300
RAM 2GB
Intel P55, H55, X58, P45, P43 chip, MB vendor ASUS Gigabyte
e SR or MSI with Intel Chipset recommended
Display card ATI Radeon 4650 or above (ATl Driver V11-2 recommended,)
Ethernet 100Base-T or above, Gigabit LAN recommended
Hard Disk 250 GB or above
05S 32 bits: MS Windows XP pro SP3/Vista SP1/Win 7 SP1/Win 8
64 bits: Win 7 SP1/Win Server 2008 R2/Win 8/Win Server 2012

Note: To determine the minimum hardware requirements for your planned surveillance system if it is not listed in the above table, please consult

the Sl (system integrator), the reseller, or D-Link Technical Support.

Note: Recording video over a long period of time will consume large amounts of disk space. Make sure that you have enough disk space available
if you want to use the recording function. You can still complete the installation even if you have less than the suggested free disk space.
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Section 1 - Product Overview

Introduction

Thank you for purchasing a D-Link IP camera, which provides state-of-the-art camera technology combined with IP network
capabilities. You can build a home or small business surveillance system by using D-Link IP cameras and the latest features
offered by the D-ViewCam application software.

Features

D-ViewCam can automatically locate and add IP cameras in the local network.
Storage management for recording files.

Single and multiple video stream monitoring (up to 32 video channels).
Two-way audio communication.

Intelligent filter and search capabilities for scheduling recording and/or event recording.
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Section 1 - Product Overview

Installing Your IP Camera

Before installing D-ViewCam, please make sure you have installed your D-Link IP camera(s) that will be managed by D-ViewCam.

Step 1 - Follow the installation procedures that came with your IP camera(s) to complete the camera
installation process.

Step 2 - Verify that you are able to view the video images from the IP camera(s) by accessing the camera’s
web-based configuration utility. It is recommended that all IP cameras be installed in the same
subnet as your management PC running the D-ViewCam software.

Step 3 - Please refer to the Add Camera step in the next section Software Installation to add IP camera(s) to
the D-ViewCam system.

Note: D-ViewCam is optimized for a small-scale LAN environment. To protect the system and cameras from attacks from the Internet,
install the D-ViewCam software on a computer that is protected behind a firewall or an IP sharing device.
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Section 2 - Installation

Software Installation

Turn on the computer and insert the D-ViewCam CD into the CD-ROM drive. Below step-by-step instructions will be shown
if you are using Windows" XP. However, similar instructions and screens will also be provided for other Windows operating

systems. When the autorun screen starts, click Install D-ViewCam.

Note: If the Installation Wizard does not start automatically, you can manually start the wizard by double-clicking the

setup.exe file from the CD.

1. Click Next to continue.

2. Select a language and click Next to continue.

D-Link D-ViewCam Surveillance System Setup Tool EI_Iﬂ_hJ

Welcome %
™ s
Welcome to Install{Update /Remove D-Link D-ViewCam Surveilance System ‘

{* Dlink D-ViewCam Bundle

DCS-100
< Back Mead > ] [ Cancel |
D-Link D-ViewCam - InstallShield Wizard = —%—
Choose Setup Language ‘ i
Select the language for the installation from the chaices below I\h
Bulgarian -

Chinese [Simplified)
Chinese [T raditional]
Croatian

Czech

[Dranizh

[utch

Englizh (United States)

m

Finnizh

French [Standard)
German

Gireek

Hungarian

Italiar

dananeca
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Section 2 - Installation

3. Select Standard Mode or Express Mode:

« Standard Mode: You will be able to select which folder
to install to and which features to install.

« Express Mode: The program will be installed to the
default folder with all the features. If you select this
option, some of the following screens will be skipped
for an easier, faster installation process.

4. Click Next to continue.

D-Link D-ViewCam - InstallShield Wizard [

Select Installation Mode
Initiation Mode

() Express mode

D-Link D-ViewCam - InstallShield Wizard [

‘Welcome to the InstallShield Wizard for D-Link
D-¥iewCam

The InstallShield Wizard will install D-Link, DiewCamn on
your computer. To continue, click Next.
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Section 2 - Installation

5. Clickl accept the terms of the license agreement radio D-Link D-ViewCam - InstallShield Wizard =

Pleaze read the following license agreement carefully.

button and then click Next to continue. License Agreement k

LICENSE STATEMENT -

All title and copyrights in and to the SOFTWARE PRODUCT are owned by
D-Link Corporation, its affiliates, or suppliers (collectively D-Link), and are
protected by domestic and intemational intellectual property laws and
international treaties. The SOFTWARE PRODUCT is non-exclusively licensed
and not sold. You (Client) acknowledze and respect any and all intellectual
property rights of D-Link, including all software, facilities, patent rizhts,
trademark rights, copyrights, specific technology and business secret of the
product and service provided. Any form of behavior damaging the intellectual
nronerty rights of DL ink is strictle forhidden Client shall not reverse ensinesr

@ 1 accept the terms of the license agreement

(0| dov ot aczept the termns of the licenze agreement

< Back H Ment > l’ Catcel ]

6. Enter your name and company name. Click Next to
. Customer Information
continue.

Pleasze enter pour infarmation.

Please enter your name atd the name of the compaty far which you wark.

Usger Mame:

Imy narne

LCormpatiy Mame:

Im_l,J compary

IrztallShield

¢ Back | Mest » I Cancel
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Section 2 - Installation

7. Select Complete to install the entire D-ViewCam software
package or select Custom to choose which programs to
install. Click Next to continue.

If you selected Custom, select which features to install on
the next page that appears, then click Next.

8. Click Install to continue. The installation process may take
a few minutes.

D-Link D-¥iewCam - InstallShield Wizard

Setup Type
Select the setup type to install

Please select a setup type.

All program featuras will be installed. [Requires the most dizk space.]

" Custom
@ Select which program features pou want installed. Becommended for

advanced users.

InstalShield

¢ Back | Mest » I Cancel

D-Link D-YiewCam - Installshield Wizard x|

Ready to Install the Program
The wizard iz ready to begin installation.

Click. Install to begin the inztallation.
I yo want ko review or change any of vour installation settings, click Back. Click Cancel o exit
the: wizard.
ImztallShield
¢ Back Cancel

D-Link D-ViewCam User Manual

11



Section 2 - Installation

9. You may be prompted to install Visual C++ Runtime
Libraries. Click Yes to install.

10. Click Yes to accept the license agreement if it appears.

11. Click Finish to complete the setup process. You may need
to restart your computer to finish installation.

uestion ]

P | Wisual C++ 2005 Runtime Libraries is the necessary component b run this product,
\'/ Would vou like to install now? (recommended)

Microsoft ¥isual C++ 2005 SP1 Redistribuktahbl o =]

Fleaze read the following license &
to zee the rest of the agreement.

iicrosaft Yisual C++ 2005 SP1 Redistribe

MICROSOFT WISUAL C++ 2005 RUNTIME LIBRARIES

These licenze terms are an agreement between Microzoft Carparation
[or bazed on where vou live, one of itz affiiates] and vou. Please read
them. They apply to the software named above, which includes the
media on which you received it, if anp. The terms alzo apply to any
ticrozaft

" updates,

* supplements,

* |nternet-bazed zervices, and

* support services

for thiz software, unless other terms accompany thoze items. | =0,
thoze terms apply.

By using the zoftware, you accept these terme. |f you do not accept j

MICROSOFT SOFTWARE LICEMSE TERMS j

Do wou accept all of the terms of the preceding Licenze Agreement? [ you
choogze Mo, [nztall will cloze. To install you must accept this agreement.

Yes | Mo |

D-Link D-ViewCam - InstallShield Wizard [

InstallShield Wizard Complete

The InstallShield \Wizard haz successfully installed D-Link
D iewCam. Before you can uze the program, pou must restart
wour cornputer.

() Mo, | will restart my computer later.

Femaove any disks from their drives, and then click Finish to
complete setup,

< Back Cancel
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Section 2 - Installation

12. To start D-ViewCam, select Start > All Programs > D-Link
D-ViewCam > Main Console.

13. Thefirst time you launch the Main Console, you will need to create
the admin password. Enter the password and then enter it again
to confirm. Click OK to continue.

B D-Link D-ViewCam
4 Windows Search

R
Flayback System
Eemote Live Viewer
# Uninstall D-ViewCam
[4] Verification Tool

EI Backup Sstem
kJd DBETook

badn Console

First Execution of Main Console System

Please enter password for administrator

Barilding Metwarks for People

UserAccount: Iadmin

Password: Il

Password Confirm: I

[J oK ] [x Cancell

D-Link D-ViewCam User Manual
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Section 2 - Installation

Add Camera(s)

14. Once the console loads, click on the General Setting

icon, click @ Setting, and then click System Setting.

P

& User Ac

Save/Load Configuration

B Log Viewer
B Badup

Network Service

DOSEREEN ]

Meeing T

15. Click on the Camera tab.

General Camera

PEn

[¥] &5 CAMO1 test

Note: If your IP cameras support UPnP, follow step 16. Otherwise,
skip to step 18.

test [~ Date 2014/09/05 el I
16. Click # to automatically find the IP camera(s) that are on your I
local area network (LAN). [ msomg ] || o |

[ Video Parameler | [ Apply All ] [ Font ]

[ ok [ X cancel :
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Section 2 - Installation

17. Select one of the IP cameras that are available. You may enter
a new name for this camera and then enter the username and
password assigned to this camera. Click OK to add the camera.

Note: The default username is admin and the default password

is blank.

18. If your camera(s) do not support UPnP or your camera(s) were
not found, you can manually add a camera.

Click the B button to manually add IP Camera(s) that are on your

local area network (LAN).

r ™
Search IP Cameras _ M
Device Found: D-Link DCS-2100G (172.17.5.251:8081) | Stop Scan {

P Vendor Model MAC
O172.17.5.145 D-Link DCS-930L f0-7d-68-06-0b-13
172.17.5.125 D-Link DCS-9321L f0-7d-68-08-71-25
[172.17.5.5 D-Link DCS-942L 28-10-7b-1b-cf-e3
O172.17.5.31 D-Link DCS-0421 28-10-7b-14-43-36 ‘
[1172.17.5.251:8081 D-Link DC5-2100G 00-13-46-da-e8-83
—IP Camera Option

Camera Mame: I

User Name: |

Password: I

[J OK ] [ X Cancel ]

General Camera | 0 Device | PTZ Gonfig | Hotiine | Address Book | Monitor Dispiay |

PElE

[ &5 CAMO1 test

Camera Setting r~Show Video Infc

test I~ Date [201anoms <]
[ Camera Number
[ Video Parameter ] 1 ApplyAl ] [ Font ]

ra

5 (X G

D-Link D-ViewCam User Manual
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Section 2 - Installation

19. Enter the following Network information for your camera:

Name - Enter a name for your camera.

IP Address - Enter the IP address of the camera. If you
want to use a domain name, then check the DNS box
and enter the domain name of the camera.

HTTP Port - 80 is the default port.

User Name - Enter the user name for the camera.
Password - Enter the password for the camera.
Protocol - Select TCP, UDP, or HTTP.

Enter the following Device information for your camera:

Auto Detect - Click the Auto Detect button to detect
the vender and model information.

Vendor - Select the brand name/vendor from the drop-
down menu.

Camera Model - Select the camera model from the
drop-down menu.

Video Channel - Select the video channel you want to
assign the camera to.

20. Click OK to add your camera.

™
IP Camera / \ideo Server Setting M

Metwork

MName: @

IP Address: [ 172 .17 . 2 191 [ DNs

Port: |80

User Mame: ]admin

Password: |

Protocol: C TCF O UDP = HTTP

Device -

Veendor: |D—Lin|~: _J [ Auto Detect

Camera Model: [pes-7510 ~|

Video Channel: W 1

Description

Video Codec:MPEG4 MJPEG

Audio Codec:PCM

Camera:1, DI:2, DO

« OK ] ’ X Cancel ]

D-Link D-ViewCam User Manual
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Section 3 - Configuration

D-ViewCam Interface Overview

This section will show you how to start and configure D-ViewCam.

To start D-ViewCam, select Start > All Programs > D-Link
D-ViewCam > Main Console.

Enter Admin as the default username and enter your password.
Click OK to log into the system.

m

|, D-Link D-ViewCam
] Backup System
kd DBTools
¥ Main Console
Playback System
E Femaote Live Viewer
£ Uninstall D-Link D-ViewCam Syste

m Verification Tools

D-Link

Building Hetworks for People

Please enter user name and password

User Mame: Im

Passwaoard: I

’q" oK l lx Cancel ]

17
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Section 3 - Configuration

Main Console

[IFOEREMIEEEN] | ERET | =

2014/09/05

10:53:54
admin

Main Display Area

Exit/Minimize Program

System Information

General Controles and
Settings

PTZ Features

o\

Split-Screen Options

D-Link D-ViewCam User Manual
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Section 3 - Configuration

Monitor

Start Monitor All
Start Recording Schedule
Start Smart Guard System

CLl ek Pl |

Open BEvent Report
Open E-Map

Open Stream Usage Panel
Open I/O Control Panel

Lock System

Option

Function

Start/Stop Monitor All

Click to start or stop all monitoring functions.

Start/Stop Recording Schedule

Click to start or stop the recording schedule.

Start/Stop Smart Guard System

Click to start or stop the smart guard system.

Open Event Report

Click to open the event report which will log any events.

Open E-Map

Click to open E-Map which monitors all devices with map
indicators.

Open Stream Usage Panel

Click to show usage information for each stream connected.

Open I/O Control Panel

Click to open the I/0 control panel which montors the DI/DO and
manual triggering the DO devices.

Lock System

Click to lock the system.

D-Link D-ViewCam User Manual
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Section 3 - Configuration

©e6 6 e

Monitor:
Click on the Start Monitor icon and select from the menu to start/stop recording schedule system or the guard system features. You
can also open monitor tools such as event report, E-Map, I/O control panel, and system lock.

Playback:

Click on the icon to open the Playback Console. You can watch recorded video, search recorded video, adjust the image of the stored
data, save video/pictures, print images, check log information and event records, and set up recording function configuration. See
the PlayBack section for details.

Schedule:
Organize the recording time schedule and configure recorder settings. See the Schedule section for details.

Guard:
Add/edit type(s) of events that you want to detect and setup action(s) responding to events. See the Guard section for details.

General Setting:
Select to modify general settings, user account settings, save/ load configuration settings, access log viewer and backup files, and
configure network services. See the Config section for details.

D-Link D-ViewCam User Manual 20



Section 3 - Configuration

System Information

Displays the date, time, free disk space, IP Camera bitrate, customized text, and network utilization.

PTZ Features

PTZ Control

Zoom

Add Preset Point/Go to Preset Point

Click on the + sign (Zoom Tele) to zoom in or click the - sign (Zoom Wide) to zoom out.

custom name to each preset. Click on the Go icon and view the result of your setting.

Control the movement of PTZ (pan/tilt/zoom) cameras. With cameras that support PTZ control, you can move, zoom,
patrol, auto pan, adjust focus, and set preset points. Click on the Home icon in the center to return to the original view.

Adjust the camera view until you are satisfied. Click on the Set icon and set up the view as the preset point 01. Adjust the
camera view again and set up the preset point 02. Repeat the process until all preset points are set. You can assign a

Note: To adjust the speed settings of the PTZ camera, go to General Setting > Setting > System Setting > PTZ Config.

Split-Screen Options

Select a split-screen display layout by clicking on the desired layout icon. The system provides 4, 6,9, 10, 13, 16, 17, and 36 split-screen modes. To
switch to single camera display, double-click the camera’s image. To return to the previous configuration screen, press the Esc key or double-click

on the screen again.

Displays 1 screen. Divides into 9 screens.

Divides into 4 screens.

Divides into 6 screens. ‘B

i EH L

Divides into 10 screens.

Divides into 13 screens.

Divides into 16 screens.

Divides into N screens.

: Divides into 13 screens.

I |

Divides into 17 screens.

- i |

-
JF
L

&)

Switch to full screen.

Rotate all screens.

D-Link D-ViewCam User Manual
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Section 3 - Configuration

Patrol
Go to Add Preset Point > Set Patrol to bring up the Patrol Setup dialog. From the left window, select the camera(s) that you would like to have in

the patrol group. Align the cameras in order in the right window and adjust the time. Rename the group name if you want. After completing the
setup, check the Active option, and then click OK.

Patrol Setup El
Group 1 ]Gmup 2 I Group 3} Group 4 I
[@rrese
@Preset2 Group Name : lroupt
FPresetD3 R i som
[ Active

[./ oK ] [X Cancell

You can set up up to four groups of auto patrol. To start or stop, click on the Go to Preset Point icon in the Main Console, and select Start Patrol
or Stop Patrol.

Auto Pan
Go to Go to Preset Point and click on Start AutoPan to enable auto pan. Click on Stop AutoPan to stop. Auto Pan enables the camera to scan an

area horizontally from left to right or right to left.

Focus
You can select to focus the camera near, far, or have it auto focus. Click on the sign to focus near, click on the sign to focus far, and click on
the center icon to auto focus. To focus near means objects that are closer will be clearer than the objects that are further away. In contrast, to focus

far means objects that are further will be clearer than the objects that are closer. Click on the icon and select auto focus if you want the system
to decide the focus point for you.
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On Screen Menu
Right-click on the camera screen and get the “On Screen” menu, from which you can quickly
adjust the settings of your camera.

Camera Setting
Click to go to the camera setting page for General Setting

Enable Talk
With cameras that support two-way audio, select Enable Talk to utilize the function.

Enable Digital PTZ

To enable the PTZ functions of the camera, select the Enable Digital PTZ option. Use the
mouse wheel or click on the + and - signs to zoom in and zoom out on the camera. The square
flashing on the video grid indicates the correspondent view of the camera.

Connect/ Disconnect
Right-click on the display screen and select Connect/Disconnect to modify the connecting
status of the camera.

Show Camera
Select the camera from the Show Camera menu to display video on selected screen. The list
of cameras will be displayed in the right column of the monitor display panel.

Delete Camera
Click on Delete Camera to remove a camera from the display screen.

Fix Aspect Ratio
Enable Fix Aspect Ratio to view the original ratio video or disable this option to stretch 3:4
to fit window.

Snapshot

Select the snapshot function to capture a screen shot of the current video. You have the option
to copy the image to clipboard or to save it. You may select the OSD option to export the
image with date/time and camera number/name text. If the digital PTZ function is enabled,
you can decide either Full size or Selected region as your snapshot region.

Camera Sefting
Enable Talk

Enable Digital PTZ

Connect

Disconnect

Show Camera
Delete Camera
Fo Aspect Ratio

Snapshot
Snapshot from Main profile
Manual Record

Togale Fullscreen

D-Link D-ViewCam User Manual

23



Section 3 - Configuration

Snapshot from Main profile
Select the snapshot function to capture a specific video image frame from camera main profile immediately. You have the options to copy the
image to clipboard or to save it

Manual Record
Select to start recording video.

Toggle Fullscreen
Select it to view live video(s) in fullscreen. Press ESC to go back to original window.
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Configuration

Click on the General Setting @ icon. Click Setting > System Setting to configure your settings.

DRDEREEN

2014/09/05
10:40:20
admin

F] 51stem setting | seting |
& User Account Setting Save/Load Configuration 3

Free:57.1GB Log Viewer
Backup

=]
Network Service
@ 6 About Main Console...
006
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General

Startup

Main Console: Check to open the Main Console system when
windows start up.

Check the following 4 main functions to auto-activate functions
when the Main Console system is starting, including Schedule
Recording System, Smart Guard System, Live Streaming
Server, and Remote Playback Server.

Full Screen: Check to launch video at full screen when launched.

Auto Lock System: auto lock system by startup or allow system
to auto login with the preset account.

Setup Auto login: Enable“Auto login”and click the Setup button
to open the Auto Login Setup panel. Enter the User Account and
Password to login automatically when the system starts. Enable
Minimize after login to minimize the Main Console window
after login.

Startup
™ Main Console

I” Schedule Recording System

[~ Smart Guard System

[ Live Streaming Server

I Remote Playback Server

[ Full Screen

[” Auto Lock System

[ Auto Login Setup

~Miscellaneous -
[~ Automatically popup event report

[ Minimize to system tray

[ Synchronize video frames

General lcameral 10 Device | PTZ Conﬁg] Hotlme} Address Book MonnorDlsplay]

Storage

Location

C:\Program Files (x86)\D-Link\D-ViewCam

Recycle Setup:

[ Video Recycling

 Status Display

¥ Current Date

¥ Current Time

¥ Login User

¥ Free Disk Space
[™ IP Camera Bitrate
[~ User Defined Text 1

-

[~ UserDefined Text 2

[ Log Recycling

Audio Preview
Default Channel (NotUsed) ~

I Enable Audio on Active Channel

Volume Ji

Auto Reboot

[~ EnableAuto Reboot
Every |Day
at (01:00 AM

¥ oK ] [ X cancel |

Auto Login Setup

User Account:
Password:
Password Confirm:

[~ Minimize after login

[J OK ] [x Cancel]

s
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Storage

Location:
Assign the default folder for the system to store data files. It is recommend that you don't save in the system
drive (C:\) to avoid a drop in your PC’s performance when free storage is low.

New Click to add a new location. Click the ... button to browse to a folder. Click
Ll OK to save the location.
H Delete Highlight a location and then click the Delete button to remove it.
1} Move Item Up ngh!lght a Ioczf\tlon ar\d click the Move Item Up button to move the
, ! location higher in the list.
Highlight a location and click the Move Item Down button to move the
% | Moveltem Down . . )
, J location lower in the list.
Video Recycling:

This option allows the user to configure different recycle criteria for different cameras and for different
recording modes of the same camera.

General setting: Set the standard limit to let the system recycle automatically. The system will start
to recycle if the disk space is less than the indicated percentage (default is 10%, minimum is 5%).

Option setting: Set different recycle days for Record 1/ Record 2 in order to keep different lengths
of recordings.

Allow exception: Drag and drop the camera(s) to the right panel and it will pop up a window al-
lowing the input of special recycle criteria. In the example below, the 2 recordings of the first cam-
era were configured with different recycle criteria: Record 1: 7 days; Record 2: 30 days.

If you expect a recording will utilize all available space, you can leave the keep x days option blank.
By setting this, the symbol will become “-’, and the length of Record 2 will depend on the remaining
available space. This also means this recoding has the lowest priority, so it would be recycled first

when disk space is insufficient in order to meet recording settings.

Storage

Location E

C:\Program Files (x86)\D-Link\D-ViewCam

Recycle Setup:

’ Video Recycling ]

l Log Recycling ]

Vides Racyc/z Sair
Sensral sezing
Hways keep 5 % disk space.
Opfional seting: kasp defined racording days
¥ Onlykeep |36£ gay(s) for Recard 1

7 Onlykesp 305 tay(s} for Recard 2.

Eaplional recycs duration

camera Recardl Racerdz
& 01 1vs_shoppng Mel 7 day(s) 30 dayls)
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Note:

1. The system will detect the storage space of default location, if the default storage space is ex-
hausted, the video will be stored on the next available directory.

2. Ifall the locations exceed the storage rule, the system will start recycling.

Recycle priority: keep % of disk space > keep x days > keep - days.

4. Recycle example:

w

Example 1: Set “keep 10% of disk space”; Current available space is still more than 10%, ex: 15%.
A. For the recordings set as “keep x days”: Main Console will start to delete the oldest recording
when it’s data length reach X days.
B. For the recordings set as “keep - days”: Main Console will continue recording and
will start deleting the oldest recording when available disk space reaches 10%.

Example 2: Set “keep 10% of disk space”; Current available space is 10%.

A. For the recordings set as “keep - days”: Main Console will start to delete the oldest recording.
The new space after deletion will be used to store the recording which is set as “Keep X days”.

B. For the recordings set as “keep X days”: Main Console will start to delete the oldest recording
when it’s data length reaches X days.

C. Main Console continues to delete the oldest recordings of “keep — days” until there remains
only 1 day. Then, Main Console will start to delete the oldest recordings from “keep x days” in
order to follow the rule of keeping 10% of disk space.

Log Recycling: Click the button to obtain the Advanced Recycle Setting panel. Set the days that
you want to keep the event or keep all event logs within interval of video files.

Event Log: Delete the event log data that is older than the number of days set.

System Log: Delete the system log data that is older than the number of days set.

o
Recycle Exomption '._ﬂ-d_

Camara  |[WS_Shopping Wall
Exceptional recyde dralion
[ Hesp T dayis] for Recond 4

i Ka=p |1':' dapis] for Recond 2.

W 0K || X cancel |
!;':\_-.rcle Excaption £
| Camera  |Camera 08
Exceplional recycle duratian
¢ Keap 7 daj(z) for Recond 1
[ Keep
|.( Ok K cancel

st s R ==
Event Log

¢ Keep event lag within interval of video files

@ Keep event lag for 7 days
System Log

" Keep system log within interval of video files

@ Keep system log for 14 days

Export and Backup Log
 Keep export and backup log within interval of video files
{* Keep export and backup log for 14 days

(" Keep export and backup log forever
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Status Display

Select the information that you wish to display in the information window on the Main Console such as Current Date, Current Time, Free Disk Space,
I[P Camera Bitrate, and User Defined Text.

Status Display

| [+ Current Date
0 09 ¢ CurrentTime
() ¥ ¥ Login User
[ v Free Disk Space
[ IP Camera Bitrate
™ User Defined Text 1
’7
[ User Defined Text 2
’7
Start Live Start Remote
DELEREEN | B """ ]| streaming Playback service

service

Miscellaneous

Automatically Popup Event Report: Make sure to stop Smart Guard System before you modify this setting, otherwise the modification will not
take place. The Event Report dialog box will automatically popup when events have been detected.

Minimize to system tray: Enable this option to display an icon in the task bar when clicking the minimize button.

Note: Enter the username and password of Main Console again when clicking the minimized Main Console icon in notification area of windows
task bar to start monitoring.

Synchronize video frames: Select to prevent tearing that may occur in the video display. However, this will increase the CPU processing load.
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Audio Preview

Default Channel: Select the audio channel that you wish to hear from.

Enable Audio on Active Channel: Select the Enable Audio on Active Channel option to hear the audio from the selected video channel on each
video grid of the Main Console. The default channel plays if the video channel isn't selected.

Volume: Adjust the volume with the “volume bar.”

[ EmEEEN | EE | =)

System plays the audio of “default channel”

[CAM1 D-Link DCS-3714 (172.17.5.76)

CREEEEEN

System plays the audio of left-top “selected channel”
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Camera

Add Camera
Four function buttons will be included in the Setting/Camera
panel.

Search: Click on the £ icon to obtain the Search IP Camera
panel. The system will start scanning automatically once the
panelis opened. You may manually stop scanning by clicking on
the Stop Scan button.

Fill in the user name and password for each IP camera found and
click OK to add it to the camera list.

Note: Drag the mouse to multi-select the cameras and theninsert
the username and password. The username and password will be
applied to all the selected cameras automatically.

General Camera II!O Device | PTZ Config | Hotlmel Address Bookl MUniturD\spIayl

O

[ 5 cAMO1 test

-Camera Settings —Show Video Infos

[rest I Date [201a0005  +] |

[ Gamera Setlings ] I™ Time [anoaco0 <]

[ Stream Profile ] ¥ Camera Number

[ Go to Web Interface ] [¢ Camera Name

[ e — I I Bitrate

[ Video Parameler ] |1 Apply Al ] | Fant |
iV ok ] [ X cancel |
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Insert: Click & Insert button to open the IP Camera/Video Server Setting panel and add IP cameras to the list.
Delete: Click aal Remove button to remove the selected IP camera(s) from the system. Click OK to finalize the modification.

Config: Click &= Config button to obtain the IP Camera/Video Server Setting panel. You can modify the IP camera settings with the Setting panel.

IP Camera / Video Server Setting Panel

Network: Fill up the Network field (including Name, IP Address, Http Port, User Name, Password and Protocol) referring to the instruction provided
by the camera manufacturer. Check “Use DNS” to use domain name instead of IP address.

Device: Choose the IP camera manufacturer from the drop-down menu. Click on Auto Detect and the model name will show in the box.

Description: Displays information about the device.

=
IP Camera / Viideo Server Setting @

Metwork

Mame: @

IP Address: | 172 .17 2 191 [ ons

Port 0

User Name: 1admin

Password: |

Protocol: " TCE UDP = HTTP

Device 1

vendor: [D-Link | Auto Detect

Camera Model: DCS-7510 b2

Wideo Channel Irs|

Description

Video CodecMPEG4 MJPEG

Audio CodecPCM

Camera:1, DI:2, DO:1

0K ] ’ X Cancel ]
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Camera Parameter

Camera List: Displays all the cameras that are connected to the system. Click the
name of the camera to edit the settings.

Camera Name: Name the camera for your convenience.

Camera Settings: Set the camera parameter such as resolution and frame rate offered
by camera vendor. If the camera supports Multi-stream, you can enable the function
by checking “Enable Multi-Stream”.

Note: The multi-stream function allows the main console to receive 3 different video
streams. Please check device pack support list for supported features.

Note: Not every camera model supports multi-stream configuration, please refer to
the latest camera support list to see if multi-stream is supported.

Stream Profile: Stream profiles are pre-defined to preferred settings which will
respond from the query of the remote live view function. Each profile has different
Format, Frame, Resolution, Quality and Bit rate (Kbps) settings.

For cameras that support the Multi-stream function, the 3 different source streams
can be connected to Main console and automatically mapped to different stream
profiles. Click a stream profile to select the source stream you would like to
change.

Go to Web Interface: Go to the web-based interface of your camera to configure
the settings (optional).

Video Parameter: Adjust the video'’s brightness, contrast, saturation, and color hue
values.

General Camera |10 Device | PTZ Gonnig | Hotine | Adaress Book | monitor Dispiay |

PEKl @

& CAMDL test

Camera Setting:

test

- Show Video

I~ Date

I™ Time

|¥ Camera Number
¥ Camera Name

I~ Bitrate

2014100105 1| |

AN10-40:00 1|

[ Video Parameter ] ||

Apply All

] | Font ] |

racsfreTy]

» Camera:

test

Select 1o Set stream profile

(Multi-stream : Nol supported)

| | Stream Profie
Man
High
Normal
Low
Minimum

Source Stream

Stream 1
Stream 1
Stream 1
Stream 1
Stream 1

Forrmat | Frame Rate
MPEG4 -

H.264 30

H.284 15

H.264 10

H.264 5

Resokution Qualty | Bitrate (Kbps)

D1 High

D1 - 500
CF Normai -
CIF - 100

Profile Properties (Change parameter for profile)

Video Preview

» Main

Source Stream Stream 1 ! Camera Setings |

[~ Keep key frame only

[ viewinReal Size

[ ok | [X cancel |
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Camera Settings

Video Format: Select the video format for the footage.
Resolution: Select the resolution.

Frame Rate: Select the frame per second.

Quality: Select the quality setting to use with the stream.

Image Adjustment: Enable image to be flipped or mirrorred.

Audio: Enable microphone or speaker if your camera has these features.

e R
S

# Enable Wull-Stream

Camera:
Stream 1 (Masn) Stream 2 Stream 3
Vigea Format [Fizea = Videa Format [z 7 Vidsa Farmat [ize =
Resolubon o 3 Resolution [par — - Resolution HALF -l
Frams Rate: m 3 Frame Rate: I — Fram Rate: |
Gualty Formaiio) - Cuaity [Formaicion v Cusity Wormaiti0) -
It 15 recommended to confg Siream 1 with highest resolution and frame rate smce Stream 1 woukd be tinded to “Main Profile” as default,
Image Adustment
@ Enatis Fip
Lighting [0 7]
Audia I
=
|
v 0K X Cancel
- -— =
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OSD (On-Screen Display) Settings

-

Choose Font

—Foreground
Font: Tahoma =
Size: |12 'I
[+ Bold [+ Edge

—Background
Transparency. —} 40

[ Default
Ok ] ’ Cancel l ' Apply
L9 &

Select the information that you wish to see on the on-screen display. Click the Font button to select the font style.
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I/0 Device

1/O Device Setting:

« Module: Name of the module and ID of the digital input/output device(s) that is connected to your system.

1 & CAMO1 D-Link DCS-3714 (172.17.5.76)
[ & camoz2 D-Link DCS-242L (172.17.5.31)
1 & CAMO3 D-Link DCS-5222L (172.17.5.14

General | Camera | VO Device  PTZ Config ‘ Hotline | Address Book | Monitor Display |

Advanced Sefting

Pan Speed

Tt Speed:

Miscellansous

PTZ Idie-Handling

Patrol Group

Setup

Setup

(X G|

« Device: This column displays the device(s) already installed to the system.

« ID: Select the I/0 port.

Digital Input Monitor: The device(s) is turned on if the dot is in red. By triggering the digital input device, the related icon will light up. This is used
to check if the device is correctly connected or not.

Digital Output Monitor: The device(s) is turned on if the dot is in red. By clicking on the icon, you may trigger the digital device connecting to the
system. This can be used to test if the output device is correctly connected.

Digital Input/Output pins of selected I/O modules
Name: Insert the name of the device (input and output).
Type: Select the device type from the drop-down menu.

1. N/O: Normal Open.
2. N/C:Normal Close.

D-Link D-ViewCam User Manual

36



Section 3 - Configuration

PTZ Config

Genelal[ Camera | U0 Device FTZ Config |Holi|ne| Address Book | Monitor Display

[ & CAMO1 D-Link DCS-3714 (172.17.5.76)
O i cAMO2 D-Link DCS-9421 (172.17.5.31)
1 & CAMO3 D-Link DCS-5222L (172.17.5.14

ddvancad Ssh.ing
Pan Speed o e )
Tin Spead: e Pl |
.... |
Miscallaneous
PTZ ldle-Handling [ setwp
Patrol Group Setup

[X_Concal |

Check the box on the camera list to activate the PTZ control function of a PTZ camera.
Advanced Setting: You may set up the pan speed, tilt speed, and zoom speed. Adjust the settings by dragging the bars.

Miscellaneous:
Patrol Group: You can set up a Patrol Group.
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Hotline

General] Camera] o Device1 PTZ Config Hotline ]Address Elook] MonitorDispIay]

~ E-Mail 1
*SMTP Server: *Port: |25

*E-Mail Sender: |

E-Mail Subject: | <No Subject=

Body Content:

[~ SMTP server needs authentication

[ Send Test Mail

v OK | ’X Cancel]

Configure the Hotline settings including E-mail, once an unusual event is detected.

E-mail: Input the following information: Server, Port, Sender’s E-mail address, E-mail’s subject title, Body content and SSL option for encrypted
transmission. Click on the Send Test Mail button to test the settings.
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Address Book

Address Book: Manage the address book from which you may send out an E-mail when an unusual event is detected.

General | Camera | 110 Device | PTZ Config | Hotline Address Book | Monitor Display

Pleasze input the name and contact information

User Mame: |

Phaone: |

E-Mail: |

Description: |

Add Clear Maodify Remaove

Contact persons

User name Phone E-Mail Description
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Monitor Display

General | Camera | 110 Device | PTZ Config | Hotine | Address Book ~Monitor Dispiay |
Primary l

Select Channel Selected Channel
—Auto Scan

45,01 D-Link DCS-2103 (192.168.0.12] {501 D-Link DCS-2103 (192.168.0.12] ) e
&502 D-Link DC5-6210 (192.168.0.11] {502 D-Link DCS-6210 (192.168.0.117 | Frimary Channel gLag

I 03 DC5-3715 & 03 DC5-3715_1
Secondary Channel ’(NotUsed} -l

Auto-scan Interval

~Layout
NxN Type:

L/ OK J lx Cancel]

Cameras List: The left column displays a list of all available cameras. Highlight the camera and click the right arrow --> to move the camera to the
right column. The right column will display the primary and secondary cameras. These cameras will be available for the auto-scan function.

Auto Scan: Activate auto scan to rotate the channels / cameras on the display screen.
For instance, you may select to show only 4 sub-screens on the Main Console while having 16 channels connected to the system. With auto scan

function, you will be able to see all 16 channels by turns. You can set up a primary channel that will always be on the screen and a secondary channel
that has secondary priority.
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The Save/Load Configuration function allows system users to save any specific setting as a .cfg (config) file. You may save up several different .cfg
files at any time.

Save Configuration: To save a specific setting, go to General Setting > Save/Load Configuration > Save. In the popup window, type in the
file name and then save it as a .cfg file.

Load Configuration: To load a specific setting, go to General Setting > Save/Load Configuration > Load. In the popup window, go to the
directory that you saved the .cfg files at, select any one of them and then click OK to load the file.

Note: Main Console will be automatically shutdown after loading a new configuration. Please re-start Main Console manually.

Sefting r

Save/Load Configuration *

B Log Viewer
B Backup

Metwork Service

About Main Console...
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Network Service

There are 2 types of network services:
Live streaming server and Remote playback server. From the Main Console, go to General Setting > Network Service to obtain the Network
Service panel.

Setting

Save/Load Configuration

B Log Viewer
B Backup

MNetwork Service

About Main Console...

Live Streaming Server

When starting the live streaming function of computer, the system allows remote users to log in to the specific computer and view cameras that
are connected to it. As system administrator, user could be able to monitor these accounts in order to maintain the system efficiency.

Main
On Live Streaming Server panel, administrator can see all the clients who are currently logging in to the computer and watching the
live video from the remote side.
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- — -
Network Service - 169.254.251.160 57 / 169.254.177.204 / 169.254.160.148 / 172.1... M_

Main | Black / White List Perrormance]
H Si e
e | Client Count o | Kill I
Streaming :
State IP Camera Bitrate (Kbps)
Remote
Playback
rSenice
Server Status: Stopped Stop
I =
~Opfions — |
l Port: |5150 Default
Maximum Connections: 154
¥ Use Default Web Server
Port: 130
¥ Save Log wLiveSeNer.Iog ™3
[¥ Enable Audio

’/ OK ] [x Cancel]

Client List

Client Count: Show the amount of channels that are connected.

Kill Client: Highlight an IP address and click on the Kill Client button to block the client from your client list.
Kill All Clients: Click on this button to block all the clients logging to your system.

Service

Server Status: Click on Start/Stop to turn on/off the server.

Options: Adjust the setting only when the server is stopped.

Port: Assign a port for the clients to connect to your system via Remote Live Viewer. Default port is 5150.

Maximum Connections: Number of connections that are allowed to connect to the system. Default is 64 channels and maximum
is 64, one camera video counts as one connection.

Use Default Web Server: Activate the Web server by checking this box. Clients will be able to watch live video via Internet Explorer.
The port for live streaming server is 80 by default.

Save Log: Save the current log information to your computer.
Enable Audio: Select this option to enable the audio transmission along with video stream.
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Black / White List

169.254.177.204 / 160.254.160.14 / 172.1... 3w

Main Black/White List | Performance |
i o
[~ Enable White List
Streaming [~ Enable Black List
= | to
Remote
Playback Add to White List Delete

Add to Black List

D | IP Range i Access
I ’ Apply to All Metwork Servers l
’J‘ OK l ’ X Cancel l

White List: Check the “Enable White List” box to activate the white list filter. Only IPs from the white list is allowed to log in.
Black List: Check the “Enable Black List” box to activate the black list filter. IPs from the black list will be blocked.

IP Address: Enter an IP address into the IP address field on the left. To add an IP address range to the system, enter 2 sets of IP address to
indicate a series of IP(s).

Add/Delete: Add the IP(s) onto the list or remove it from the list.
Apply to All Network Servers: Apply the settings to both live streaming server and remote playback server.
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Performance

- T
MNetwork Service - 169.254 251 160 E 1@254.1515? J169254 177 204 169 254160148 f1721 @

Main ] Black / White List Performance ]

Live Total bitrate: 0.0Kbps

II )
Remote
Playback

On the performance panel, an administrator can see the total bitrate for all the clients that are currently connected to the computer receiving the
video live view stream. This allows the administrator to monitor individual camera bit rates for specific camera connections.
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Remote Playback Server

When starting the remote playback function, the system allows remote users to log in to the Network Service - 160354 251160 TBR 354 15157 / 169254 177 204 / 163.254.160.148 / 172.1.
specific computer and withdraw data files that are stored on it. As system administrator, user Main | Black White List | Pedformance |
could be able to monitor the accounts logging in to maintain the system efficiency. ! e User Gount o [ ][
’ P User Bitrate (Kbps)
Main
ybadl
On the Remote Playback Server panel, all the clients who are currently logged into the
computer and watching the playback video from the remote side. senvice
I Server Status: Stopped Stop
. 0 | ions
CIIent LISt DF::F!: 5160 __Default
Maximum Users 'T
User Count: Show the amount of users that are connecting to system. v o —
¥ Save Log ‘Remmeplaynacklng Y
I |
Kill Client: Highlight an IP address and click on the Kill Client button to block the e
client from your client list.

Kill All Clients: Click on this button to block all the clients logging in to your system.
Service

Server Status: Click on Start/Stop to turn on/off this option.
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Options

Port: Assign a port for the clients to connect to your system via Remote playback server. Default port is 5160.
Maximum Users: Number of connections that are allowed to connect to the system. Default is 16 users and maximum is 16.
Note: One user counts as one account that is logging in to the server.

Use Default Web Server: Activate the Web server by checking this box. Clients will be able to watch live video via Internet Explorer. The port for
live streaming server is set to 80 by default.

Save Log: Save the current log information.

Note: The server must be stopped before editing any settings.
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Black / White List

| Network Service - 169.254.251.160 /169.254.151.57 / 169.254.177.204 / 169.254.160.148 / 172.1...

Main  Black/White List pemrmance]

Eii [~ Enable White List
Streaming [~ Enable Black List

] . . . to

Remote
Playback] Add to White List Delete

Add to Black List

1D IP Range Access
I
I ’ Apply to All Metwork Servers ]
’./ OK ] ’x Cancel]

White List: Check the “Enable White List” box to activate the white list filter. Only IPs from the white list is allowed to log in.
Black List: Check the “Enable Black List” box to activate the black list filter. IPs from the black list will be blocked.

IP Address: Enter an IP address into the IP address field on the left. To add an IP address range to the system, enter 2 sets of IP address to indicate
a series of IP(s).

Add/Delete: Add the IP(s) onto the list or remove it from the list.

Apply to All Network Servers: Apply the settings to both live streaming server and remote playback server.
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Performance

fF ™y
Network Service - 160,254 251,160 / 168254 151.57 / 169.254.177.204 / 169.254.160.148 / 172.1... [medem
e
Main | Black/White List Performance | |

Li‘-'E. Total bitrate: 0.0Kbps
Streaming

Remote
Playback

On the performance panel, an administrator can see the total bitrate for all the clients that are currently connected to the computer receiving the
remote playback stream. This allows the administrator to monitor individual camera bit rates for specific camera connections.

D-Link D-ViewCam User Manual 49



Section 3 - Configuration

About Main Console

Go to About Main Console to view the version of your D-ViewCam software and model name information.

; About Main Conscle
Setting k k
SH"-"EJ" Load ':Drlﬁgumtiﬂrl b | _ D-Link D-ViewCam 4.0.1
W @ 20042014
! . D-Link All rights reserved.
B Log Viewer
httpffaren dlink comd
B Backup .
~ Product Information
[ Metwork Senvice Model Type: DCS-100
Device Pack Version: 2.0.2
Camera

IP Camera License Mumber: 32

First Adapter MAC: f0-1f-af-3e-ec-10
. Second Adapter MAC:

Note: The above examples are for demonstration purposes only. Please check the D-Link website for the latest updates.
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Schedule

Click on the Schedule icon on the Main Console to set up the time duration for video recording.

B load g Comvin 5 15 Wotion

E""E-d‘ﬁ“'t | |8 Defauk i 12 13 14 15 16 17 18 19 20 21 22 23 24 |ﬁ

@ 01 D-Link DCS-2107 |1 b ink DCS-
[= 02 D-Link DCS-6211

) D-Link DCS-63

I
|l pes-3715 |

¥ Delet: @4 Configure

Start End Maode Stream Profile FPS Qualty Res
00:00 23:59 Always  Main - - 12

[_@ Day Mode

[D Week Mode
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Day Mode

Schedule the camera(s) to record video at the same time every day.

There are three ways to setup the time schedule for each camera:
1. Load a preset mode or
2. Insert a new schedule manually or
3. Copy to other cameras after manually setup.

. Abedss .\”0“\3"
E] Default |I'J Deefansk 5 1 3 3 4 % & T § % W § o2 o9 o ouow 7 ouow w2 n ul

&= 01 n-L.nLDI:S-:-.zz;I i D-Uink DCS- =]

!‘: Deleie ﬂ Confipors
Start End Made Stream Profle  FPS (naalty R
0000 23:59 AMNEYS Mamn

' Defauk | Custom

[sg  Daweoe |
] Weak Made

@ X Cancel iJ

D-Link D-ViewCam User Manual

52



Section 3 - Configuration

Load Preset Modes
The system provides six modes to quickly setup recording schedule. Click on the
preset mode. Refer below tables for the definitions of each mode in each series.

5 Load to bring up the drop-down menu to select the

Mcdé -Fcrmct Time Record key frame | Adjust video Profile
Mode only frame

Regular ﬁ;;éfmz& 00:00-24:00 Always ’):r:c’h(; uncheck Main
Office ﬂ?;éfmz | 08002000 | Aways = :i‘ffﬁ/ Main
Shop m;’JEP(EfjH.Q S 10002200 | Aways ——— :E*E?ﬁf Main
Highly Secure m:EPéfjH.Q ] 00:00-2400 | Aways — uncheck Main
Disk Saving ﬁ?;éfmz ] 0000-2400 | Mofion J;;;;;f 10 fps Main
Minor ﬂ?;éfmz ] 0000-2400 | Motion = — S fps Main
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Insert a New Schedule Manually

Step 1

Left-click and draw the bar you want to add to the time table. The scheduled time will show as a grey bar.

fhlosd @ Coprio {5 I B Always Wotion

“ault E Default o 1 2 3 ] 5§ L] i 2 k) 10 11 12 12 14 15 18 17 18 18 20 21 2 23 24!ﬁ
-

01 D-Link DCS-2103 (192.168
02 D-Link DCS-6210 (192.168
03 DC5-3715 | D-Link DCS-63

] D-Link DCS-

[
) pcs-a715

59 Delete 9 Contigure

Start End Mode Stream Profile FPS Quality Res

Day Mode

[D Week Mode

Step 2
Change the settings by clicking on the Configure icon or double-click the schedule information.

Step 3
Click OK.

L\/ oK J Ix Cancel ]
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Copy Schedule

You may set up the schedule for each channel/camera by repeating the process above, or simply apply the settings of a single camera to all the
others by clicking the Copy To icon on the top of the display window.

Week Mode

Schedule the camera(s) for each day of the week. In addition, you may assign holidays under the Week Mode.

Default
Follow the same process to setup the schedule for every day in a week.

Holiday
You may assign holidays where the system will work according to the Sunday setting.

Custom
You can assign a particular date(s) on which the system will work according to a special schedule(s) different from the others.

fleed @Coryin 5 35 B Aiways Wvotion
= Default | B oesa715 o 1 2 3 4 s e 7 8 s w m 12 w3 s 5 e w18 19 @ 21 2 2 |
--ﬁ 01 D-Link DCS-210] g gnday -
F-iE 02 D-Link DCS-6210
B 03 DCS-3715 'L monday
- [ad sunday I
[ Monday m v
[ Tuesday ] Wednesday
[ wednesday
[ Thursday i Thursday
[ Friday
.. saturday L[l Friday | vl

¥ Delete @4 Contigure

Start End Mode Stream Profie  FPS Qualty Ret
00:00 23:59 Always Main - 19;

[D Day Mode ]

[_@ Week Mode ]
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Adjust the Schedule Settings
You can manually change the settings at any time after you insert or load a schedule.

Option 1: Move the cursor to the Time Bar and slide the bar to the left or right to change the start and end points.

Option 2: Click on the Configure icon or double-click on the schedule information on the screen (highlighted in blue) to open
the Encoding Option panel (next page) and change the settings.

stant [ 00 = Enu|2359 i

Record 1 Video Preview
Record made: Dpbion e
fﬂemrdon Wotion j [~ Recordsudio

[ Keep key frame only

Video profilg:
*Video profile frama rate: MiA
| ain = * The actual fps depends on camera
streaming capability,
Pre-racord: TE— s@c. (Max 60)
Poskrecord 13 sec. (Max 60)
Set Detection Zone ] Vigw in Real Size Jl
[# Enable Dual Record
Record 2 Video Fresiew
Record mode: Dption A
|aways Recors = ™ Record Audio
Video profile [T Keep key frama only
= Vigeo profile frame rate; MiA
E“a'” ﬂ * The achual fps depends on camera

siraaming capability.
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Section 3 - Configuration

Encoding Option

B Alwars

(& R O S S e T S T N S S

v - g : . : S
stant [[o0 —  End [2359 =
Record 1 Video Preview
Record made: Cption [T

!Hennrd on Motion I~ Record Audio

Video profile: I~ Keep keyframe only

* Video profile frama rate: NiA

[main * Tha achial fps depends on camers
Streaming capability,

Pre-record: |5 sec. (Max 60)
Postrecord 13 sec. (Max 60)

Set Detection Zone | L View in Real Size J

W Enable Dual Record
-Record 2

Record mode: Option

|&tways Record I Record Audio

Video profile [T Keep keyframe anly
" Video profile frame rate: N/IA

{Main * The actual fps depends on camera
streaming capability.

View in Real Size |

o ) [ cman |
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Record Mode

There are 2 recording modes and 5 video profiles to choose from. Please choose one that best suits your scenario.

Always Record
Select this option to record video continuously.

Record on Motion

Select this option to start recording when motions are detected. Please adjust sensitivity, the frame interval, and set up the detection zone
to detect motion. Frame interval is the interval in the number of frames between each check by D-ViewCam. To set up a single detection
zone, left-click and drag the mouse to draw a rectangle. To set up more than one detection zone, simply repeat the same process or click
All to select the entire screen.

Note: The maximum number of rectangle detection zones you may create is 10.

Enable Dual Record: recording two video streaming from IP camera at the same time.

W Always W Motion
] | S S S S S S
] D-Link DCS-

stant [0000 =]  Enc [2359 —

Record 1 Video Preview

Record mode: Option

x| | T RecordAudio
Video profile: I™ Keep key frame only
* Video profile frame rate: N/A
Main =l * The actual fps depends on camera

streaming capability.

Pre-record [5 sec maxe0)
Post-record 3 sec. (Max 60)

Set Detection Zone View in Real Size

Record Audio: Use the check box to enable or disable audio recording

Keep key-frame only: System will only record key frames of the video stream.

Note: The key frame interval is controlled by each camera manufacturer and cannot be adjusted.

Pre-record/Post-record Time

The pre-record/post-record function saves the recording data accordingly. For instance, to set up a 5 second pre-record time means the system will

start saving the recording data 5 seconds before the event happens.
Note: The maximum record period is 60 seconds.
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Playback

The Playback console allows you to watch the recorded video, view and/or search for unusual events, and view recorded system information.

[2014/09/05
15:36:00

=

" 9000000
PAUSE = =

.F."\ o~

& £ O

®

® O

1 Information Window 5 Cue (Start/Stop Point) 9 Save image & Export Video 13 | Open Record

2 Play/Rewind/Fast Forward 6 Speed 10 | Post Processing Tool & Backup 14 | Minimize Window
3 Volume Control 7 Zoom 11 | General Setting 15 | Exit Window

4 Scroll Bar 8 Print & Log Viewer 12 | Screen Division

A0 @PEE 00 A
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i hwiNn-Re

N o

10.

11.
12.

13‘

14.
15.

Information Window: Display video date and time, current video status, cue in/out points’time, and speed.
Play/Rewind/Fast Forward: Control the video.

Audio Volume Control: Adjust the sound level.

Scroll Bar: Indicates the status of the playing video; drag it to where you want to review.

Cue: When playing video, click on the Cue In/Cue Out icon to set the starting/ending point of a saved video clip.
The Cue In and Cue Out time will be displayed on the Playback Information Window once they are set.

Speed: Control the speed of the playing video. Click + to speed up and - to slow down.
Zoom: Zoom in and out of the recorded video.

Print & Log Viewer: Click to open the Print window and @ to open the Log Viewer window.

Save image & Export: Click 1) to take a picture and B to open the Export window.

Post Processing Tool & Backup: Click &)

General Setting: Click Q to open the General Setting window

Screen Division: Allocate the sub-screen display by clicking on the desired layout. To switch to a single camera
display, double-click on a particular sub-screen. Double click on the screen again to restore the previous screen
division layout. To view in fullscreen mode, right-click on the screen to enable Toggle Fullscreen.

Open Record: Click on the Open Record button to access the Date Time Panel.

Minimize: Minimize the Playback console.

Exit: Close the Playback window.

to open the Enhancement window and to open the Backup window.
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Date Time Panel

Event Calor Display Settings Yileotrenew
v Enable Preview

4 AR 2014 + Color Event Type
y —[ General Motion
%31 123 4[5 6 B

Signal Lost
¥ 7 B8 910111213
|14 1516 17 18 19 20
3| 21 22 23 24 25 26 27
0282930 1 2 3 4
4| 5 6 7 8 91011

[¥ Show Recording Schedule

[~ Show EventLog

Start Time |2014M9M5 =i ‘DD'DD'DD — End Time: 20140905 = |00:00:00 =

| o +l=. 09/05 |’J 1 2z 3 4 5 B T 8 ] 10 1" 12 13 14 15 168
8 p-Link DCS-2103 | . i‘ |
i3 p-Link DCs-6210 | .
i pcs-3715
fH camera 4
iH camenra 5
3 camera 6
fH camera 7

B camera 8 E
) —r———— Bl »

.Alwavs Record — Video Overlap
[l Record on Motion [./ oK ] |x Cancel ] I

K

Record Display Window
The record display window shows the information of the available video clips. It may show in calendar or list control view.

/;j . Remote Server Site: Open Remote Playback Site Management dialog could select to access local machine or set up remote playback
< server. Select Folder option could directly access recorded data folder or use Recent List to access previous browser recorded folders.
Note: To use Select Folder function need password of Main Console.

Refresh: To refresh the record display window.

Log Viewer: To access the Log Viewer Tool.

Previous Days: To show recorded video from the previous recording date.

Next Days: To show recorded video of the next recording date.

OCO0OL S
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Date Time Period

Select the starting and ending time points that indicate the time period you would like to view.

Video Preview

Check the Enable Preview box to view the selected video.

Event Type

You can change the color by clicking on the color bar and then click the down arrow.

Time Table

|Cmnr T ‘EventTvpa

b [ [——"]eneral wation

I

EEEEE
ENEDE
CEEEE
CEmEO

COher

nal Lost

« Clickthe = icon to select all channels or the == icon to deselect all channels. Finally, utilize the scale bar to modify the scale of the time

table.

« Check the Show Records box to display the time period of recording data.

1 AR 2014

=31 1 2 3 4[5 &
w| 7 8 9101112 13
=14 15 16 17 18 19 20
| 21 22 23 24 25 26 27
«(282030 1 2 3 4
4|56 7 8 91011

I+ Show Recording Schedule

[ Show Event Log

oO

Calor

|Start Time: |2014."09."D5

=] |un:nu:uu

Event Type
General Motion
Signal Lost

End Time: ]zmmgms =) |E

|0 += 09/05]5

1

z

4 5 ]

il

]

g

i p-Link DCs-2103 4
{3 p-Link DCs-6210 |
[H pes-a715
B3 camera 4
[ camera 5
B camera 6
_EEI Camera 7
8 camerz 8
—r— 4

R
ToQeeeese

#

| —— ?+.|

* Support for dual playback: If the camera has dual recording feature, you can click the numeric button near the camera name to switch between

2 recording schedules (thick line) and available recordings (thin line).
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« Click the Show Event Log button to display the time of event detection:

Color Event Tape
Creneral Motion
Signal Lozt

To Withdraw the Record

Step 1: From the record display window at the top left of the Date Time Panel, select the date you want to view the recorded video
from. The red/green/blue lines shown on the time table indicate available recorded video records.

Note: The record display window can be shown in (a) calendar view or (b) list control view. To modify the settings of the
record display window, click on the Settings button at the right of the Playback Console.

Step 2: Use color bars to differentiate event types from each other.

Step 3: Highlight the video clip you want to review by left-clicking and dragging the time period. You may also utilize the Start Time
and End Time in the Date Time Period Section. In addition, modify the scale of the time table with the + and - signs on the
bottom left.

Step 4: Check the Enable Preview option to view the video you select.

Step 5: Click OK when finished.
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Post Processing Tool

General Setting

Select the option to either apply the filter settings to only the active channels or
to all channels.

Filter Setting

Visibility: Check the box and adjust the gamma value of the image to enhance
the image and make it cleaner.

Sharpen: Check the box to activate. Move the slider control to the right to sharpen
the image or to the left to soften it.

Brightness: Check the box to activate. Move the slider control to the right to make
the image brighter.

Contrast: Check the box to activate the function. Move the slider control to the
right to increase contrast.

Grey Scale: Check the box to show the record in grey scale mode so the image
displays in black and white.
Default: Click to change the settings back to the default settings.

OK: Click to save and apply your settings.

Fost Processing Tool -

-Zeneral Setting -

= Apply active channel

- Filter Setting
[ Visibility

[T Sharpen

[~ Brightness

[ Contrast

[T Grey Scale

] [ Default
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Save Video
Step 1: Click on the display screen to select the camera display that you want to save as a video clip.
Step 2: Click the cue in B4 and cue out K& buttons to select the start and end points. The cue in and cue out time will show in the information
window.
[2014/09/05 E=lh il o)
15:03:00 1x 0 ) P —
Step 3: Click the Save Video icon. Select the location where you want to save the file at and enter
the file name. Click Save. _
Export File Path:
Step 4: Set the Export Format from the drop-down (ASF or AVI). memmm_
|asF
Step 5: Select the profile to use from the Use Profile drop-down. Use Protile
J‘.".findows Media Video 8 for Local Area Metwork (384 Kbps) j
Step 6: Select to export (i.e. save) the recorded video with Audio, OSD (On-Screen Display), or o e e
export video only. Start Time: 20140005 = [150300 —
End Time: |20140005 = |15:1231 =
Step 7: Click OK to save the video.

[~ ExportAudio

|v Export OSD

[/ oK ]’x Cancel]

D-Link D-ViewCam User Manual

65



Section 3 - Configuration

Save Image (Snapshot)
Step 1: Click on the display screen to select the camera display from which you want to save pictures.

Click the Save Image button when the image you want is displayed on the screen. You may click Pause to freeze the video and use the

Step 2:
Step Forward/Step Backward buttons to find the picture that you want to save.

Step 3: Check the OSD box to export the image with the date/time and camera number/name displayed. If the digital PTZ function is enabled in
the display view, you can also select either Full size or Selected Region as your image region.

Step 4: You have the option to copy the image to the clipboard or to save it to your computer. Click Save Image and select the folder you want

to save it to. Select the image format (BMP or JPEG) and click Save.

¥

’ r
- % w

i
-

|
.
Sy

v 0SD Region: |Full size vI
e ) [_om |
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Print

Print the current image of the video you have selected.

Print Content: Print the image from the selected channel or all the channels shown
on the screen.

Page Setting: Set to print the image at the Original Size or Fit to Page. Set the
alignment from the Align Image drop-down (Top, Center, or Bottom).

Print: Click to print the image.

,

Print Content
Select channels :

@ Print active channel image

Select printed region ofimages
" Original
s Selected region

Page Setting
@ Original size

" Fitto page

Align Image:

Top -

lJ Print ] [x Cance\]

Backup

The Backup function saves everything from the Playback panel, including log information.
You can start a full function Playback Console and load the backup files into it on any PC with Windows
operating system.This means you may monitor the real time video and work on the backup files on separate
computers simultaneously.
Step 1: Press the Open Record button and click Backup.
Step 2: In the Date Time Period section, select the Start Time and End Time you want to back up.
Step 3: In the Select Camera(s) section, select the camera(s) you want to back up.
Step 4: Click the Calculate Size button to calculate the size of the backup data.
Step 5: Under Media, select where you would like to save the backup data.

Step 6: Under Option, check the type of data you want to back up.

Step 7: Click the Backup button to start backing up.

Note: The backup cannot exceed 7 days of recordings.

Date Time Period
Start Time:

End Time:

Select Camera(s)

® 9| X0 xn

116 |17-32| 3348 4964

EXNIENEEVE

K2 K13 K 14| K15 || X 16

, ,

EfE0s0s - [1507.00 =
201409105 - [15:2000 -

4|[xs5][xe][x7]xs

[ Calculate Size ] [

SelectAl || Deselectan |

Media
(" Backup using CDROM
(" Backup using DVD
¢ Backup on HardDisk

Option
[~ Backup EventLog
I~ Backup System Log

7o) (X ]
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13.Modify Schedule

14. Modify Configuration
15. Start Live Streaming Server
16. Stop Live Streaming Server

17. Modify Live Streaming Server

Log Viewer
System Log
Select Log Type form the drop-down menu. There are total 23 types of log types, including:
1. Main Console Startup 7.Execute Recycle
2. Main Console Shutdown 8. Enable Channel
3. User Login 9. Disable Channel
4. User Login Failed 10. Start Smart Guard
5. Start Schedule 11. Stop Smart Guard
6. Stop Schedule 12. Modify Smart Guard

oo

System Log ] Export and Backup Log ] Unusual Evsm;

18. Start Remote Playback Server

- e

2014/09/05 12:11:11
2014/09/05 15:01:20

Modify Configuration
Start Schedule

<«

T

=

Log Type All i

Date [~ 2014100005 - = Exportto...
Date Time [ 20140805 151220 - = 1o [~ 2014109105 15:12:28 ~ = Search
Event Time Event Type Device Description
2014/09/05 10:13:28 Main Console Startup

2014/09/05 10:13:38 Main Console Shutdown

2014/09/05 10:26:13 Main Console Startup

2014/09/05 10:52:21 Main Console Shutdown

2014/09/05 10:52:29 Main Console Startup

2014/09/05 10:53:08 User Lagin admin
2014/09/05 10:53:38 Modify Configuration

2014/09/05 11:32:15 Enable Channel i CAM1
2014/09/05 11:32:15 Enable Channel 2 CAMZ
2014/09/05 11:32:15 Enable Channel 3 CAM3
2014/09/05 11:32:15 Enable Channel 4 CAM4
2014/09/05 11:32:18 Modify Configuration

2014/09/05 12:03:56 IP Camera Connection Lost 3 172.17.5.31
2014/09/05 12:04:12 IP Camera Connection Regained 3 172.17.5.31
2014/09/05 12:08:55 Enable Channel 1 CAML
2014/09/05 12:08:55 Enable Channel 2 CAM2
2014/09/05 12:08:58 Modify Configuration

2014/09/05 12:08:59 IP Camera Connection Lost 1 192.168.0.12
2014/09/05 12:10:02 IP Camera Connection Regained 1 192.168.0.12
2014/09/05 12:11:07 Enable Channel 3 CAM3

Step 1: Select the type of event you want to check or select All from the drop-down menu.

19. Stop Remote Playback Server
20. Modify Remote Playback Server
21.1P Camera Connection Lost

22. Auto Restart Windows

23. Modify E-Map

Step 2: View the events that happened on a particular date or during a given time period by selecting search period.

Step 3: Click the Search button.

Step 4: You can export the data to a text file (.txt) or Excel file (.xlIs). Click the Export to button, enter the filename, and select the format to export

to.
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Export and Backup Log

View the Export and Backup Log history that had been operated by local or remote user.

Step1: Choose the type of event you want to check or select All from the drop-down menu for all types of events.
Step 2:View the events that happened on a particular date or during a given time period by selecting search period.
For a particular data: check the Date box right and indicate the date.

For a period: check the Date Time and then enter the date and time.

Step 3: Click Search

System Log Export and Backup Log | Unusual Eventl

Log Type: |AII j

Date: [+ 2014108105 - 3 Exportto...
Date Time: Il 20140005 151229 - 2] to [T 2014109005 15:12:29 - 2] Search

Event Time | Event Type | Success | Usernamea | Start Time | End Time
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Unusual Event
View the unusual event history that had been detected by the Smart Guard System.

Step 1: Select the type of events you wish to view or select All from the drop-down menu to view all types of events. The types of
Unusual Event include General Motion, and Signal Lost.

Step 2: Select the camera channel you wish to view or select All for all the channels available.

Step 3: View the events that happened on a particular date or during a given time period by selecting the search period.
For a particular data: check the Date box right and indicate the date.
For a period: check the Date&Time and then enter the date and time.

Step 4: Click Search.

Note: When working with a video record, Log Viewer will search for Unusual Event in the video record in Date & Time mode, start from
the beginning to the end of the record, which is the default setting of the system. A link will appear right next to each event time. By
clicking on the link, the video will jump to the point where the unusual event takes place.

! Log Viewer

System Log ] Export and Backup Log Unusual Event i

Log Type: All -

Channel All -

Date: | 201410005 ~ = Export to

Date Time: \F 2014/09/05 15:07:00 ~ 2 1o |[72014r09r0515.20.00 e Search l

| Event Time | Event Type. | camera | Description.
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General Setting - Record Display

Calendar View (left):
Display in calendar view.

List Control (right):
Display in list view.

Play

- Play when open: Check this option to start playing the video clip every time
when a record is withdrawn.

+ Auto skip when record motion only mode: Check this option to set up the
system to automatically skip to the points where there were motions recorded.

+ Next interval: Set the interval with which the video goes forward when you
click on the Next icon on the control panel.

- Previous interval: Set the interval with which the video goes backward when
you click on the Previous icon on the control panel.

Capture Image

 Savein clipboard: The image will be saved in the clipboard and can be pasted
to other applications.

- Manually save the image file: You can manually select where you want to save
the image, name the saved file, and the format you want to save the image.

- Automatically save the image file: By pre-setting a path/URL and the image
format, the system will automatically save the image accordingly when you
click the Save button in the control panel.

Miscellaneous

« Synchronize video frames: Select to prevent tearing that may occur in the
video display. However, this will increase the CPU processing load.

=

General | Server| 08D |
— Record Display

{+ Calendar View

Play
[~ Play when open

¥ Auto skip when record motion only mode

_J:‘ min
1 __J:I min

Mext interval:

Previous interval:

—Capture Image —

" Save in clipboard
i+ Manually save the image file

" Automatically save the image file

" List Control

- Miscellaneous -

[~ Synchronize video frames

©-#X0O0

I OK | ’x Cancel ]

©-#X00

1 +H 2009 »

123 4
5 6 7 8 91011
1213141516 17 18
[19]20 21 22 23 24 25
26 27 28 29 30 31

- &7 Record Date;
2009/07/19
2009/07/17
[ 2o009/07/16
2009/07/15
8 2009/07/14
2009/07/13

B zo09,/07,/12
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Remote Server

Add Remote Playback Site

Click the Remote Server icon to add and setup a remote playback site.
Step 1: Enter the IP address or DNS, Port, Username, and Password.
Step 2: Click Add to add the server.

Step 3: Click OK to exit.

Access Remote Playback Site

Go to the Date Time Panel and click the L{-:j " icon on the top of the display

window to access the Remote Playback Site.

==

General Server |0sD |

Server Name:
s

Port: 5160
User Name:
Password:

Add Delete Update

Server Setting test (127.0.0.1)

G- ®Q00

Local Machine
Eecent List
welect Folder..

Eemote PC 1 (192.168.1.100]
Eemote PC 2 (192.1658.1.101)
Eemote PC 3 (192.1658.1.102)
Eemota PC 4 (192.1658.1.1032)
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OSD Setting

Check the Enable Camera OSD box to display video information on recording video. Information includes camera name, camera number, date
and time. Users also can set up the font, size, font color and any font effects desired.

General' Server OSD |

|v Enable camera OSD
—Foreground

Font | Tahoma

Size:

Color:
[v Bold

—Background

Color:

Transparency:

~Info
|¥ Camera Mame

¥ Camera Number

[+ Date |2[J14|'09f05 vl
v Time i'FﬁFU3:53:21 vl

Default

[« oK | [x Cancel ]

Switch Recordings | Toggle Fullscreen

With dual recording support, user can switch between Record 1 and Record 2 on right click screen LR il
menu as below. Select Record File v Record 1
P | 2 Record 2
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Smart Guard Configuration

—Event ~Resion
RREBE.| G O|la @ o a
-4k CAMO1 D-Link DCS-2103 (192.2 Action Options

=) CAMO2 D-Link DCS-6210 (192.
i m CAMO3 DCS-3715
.-[#] Digital Input/Output

- Video Previ

[ ——— r

l [\/ 0K ] [x Cancel]

Click on the Smart Guard Configuration icon "% on the Main Console to start the Event and Action Configuration panel. You need to specify
an event to be detected and set up an action in which the system will take when the specified event is detected.

Note: To access the Event Report, click Start > Open Event Report.
5

Event Time | Event Type | Camera ‘ Description |
'$.2005/11/21 15:16:14  General Motion g

Cancel Event Cancel All Close
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Event

There are 2 sources of events: Camera (video image) and Digital Input. You can assign multiple events by following the instructions below.

] DEE =
G CAMO1 D-Link DCS-2103 (192.. Action Options
hid CAMO2 D-Link DCS-6210 (192..
4§ CAMO3 DCS-3715

&) Digital Input/Output

v oK
Assign a Camera Event
Step 1: Select a channel from the camera list and click the Insert Event icon.
f Select Event ﬂﬁ
Event Type Description
il Signal Lost Detect video signal connection
@, General Motion 1 Detection of any movement

’/ oK ] ’x Cancel ]

Step 2: There are two types of events: Signal Lost and General Motion. Select the event you want in the Event Type list and click OK.

Step 3: Configure the setting of the Event Type. Refer to the next page.
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Camera Event Settings

Basic setting of video Signal Lost and General Motion.
Enable Event: Check the box to activate the event.
Retrigger after status change: Check this option to retrigger after status change

Life Cycle:

« Automatic cancel event when event disappears: The alarm/action will be cancelled

once the event is fixed or ended.

« Manually cancel event or event last triggered: The alarm/action will remain until
being cancelled from Mainconsole. Choose this option to avoiding missing any
alarms.

Note: To cancel the event:
Method 1: Start > Open Event Report > Cancel All Events

Method 2 : Click the red crystal ball to obtain the Smart Guard Event Report. Click

to cancel the event(s).

« Cancel event after ___seconds: Enable checkbox and set a timer for canceling the

event after a specific time.

Activated Period:
« Always activated: Allow alarm to be activated at all times.

« As Day Mode Schedule: Customize a specific time range for the alarm to be
activated.
The alarm will be available daily according to your settings.
Click Day Schedule to General Setting the schedule.
Choose Add Time Period and drag on the coverage bar to define an activated
schedule.
Choose Remove Time Period and drag on the coverage bar to subtract from
existing schedules.

r
Alarm Event Configuration

Basic | Agvancad

¥ Enakle Event

I Retrigger after status changs

Life Cycle

% Automatic cancel event when event dissppear
" Manual cancel event or eventlast tiggered
" Cancel event after ,1'17 seconds

Activated Period

* Aways activatad

" Ag Day Mode Schedule Day Schedule

¢ As Week Mode Scheduls Week Schedule

i/ Ok | [ X cancel

= = ——
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Click Clear All to remove all settings.

As Week Mode Schedule: Customize a weekly based time range for the
alarm to be activated.

Click Week Schedule to General Setting the schedule.

Choose Add Time Period and drag on the coverage bar to define an acti-
vated schedule.

Choose Remove Time Period and drag on the coverage bar to subtract from
existing schedules.

Click Clear All to remove all settings.

Camera Event - Signal Lost
Detect the loss of video signal from camera.

Camera Event - General Motion

Detect any movement in the defined detection zone.

For each video channel you may define up to 5 motion detection profiles
(General Motion 1-5). This will allow you to set different sensitivity levels for
different regions in the same video.

Schedule Confignration &
" Add Time Pariod * Ramove Time Period Clear All
||f| Coverage |n 103 @ 4 & B 7 @ @ 10 1 12 13 14 16 18 17 13 18 0 B I 23 24
i Cay
| | X cancal
| Scheduls Configmation
& Aidd Time Period " Remove Tims Petiod Claar All ]
|E Couetans |n fo2 9 4 & @ 7 8 4 10 11 42 1% 14 E 16 {7 1@ 1D 0 2% = 20 24
1] Sunday
1] Monday I —
11 Tussday —— ———
11 wodnesday I I—
1] Thursday —— —
i Friday —— —
1] Saturday

r
Alarm Event Confignmtion

Basic  Advanced

[ Start it on |

Event Marne: | Genaral Mation 1
Alarm Event Cplion Widan P ravigw:
Sensiiiiy:
. ) . Momial
Interal:
—r— 3
r
Region DEfnition
# Define delection zone
~
[ &l | [ ol |

f/ [al ] [)( ¢ance||
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Event Name: Customize your event name here.

Alarm Event Option:

Sensitivity: Click and move the slider control to the right to increase sensitivity so
that minimal movement will trigger the alarm. Move the bar to the left to reduce
the sensitivity. Setting up an appropriate sensitivity value will minimize false alarms.
For example, you can lower the sensitivity to avoid the alarm being triggered by a
swinging tree in the breeze.

Interval: Click and move the slider control to the right to increase interval time
so that the alarm will only be triggered when the movement lasts longer. Move to
the left to reduce the interval

Region Definition:

Define detection zone: To detect General Motion, you have to define a detection
zone. Left-clickand drag the mouse to draw a detection zone. You may define more
than one zone on the screen by repeating the same process. User can also Click
“All” button to select the entire detection zone.

Start Simulation: Click the Start Simulation button and test the function on the
preview screen.

Camera Event - General Motion (Device)
Detect movement with motion detectors of devices (IP cameras or video servers).

Note: This function only available on devices with built-in motion detection.

Please refer to the user manual of your device to set up motion detection.

Start Simulation
Click to test if motion detection is set up correctly

Go to Web Interface
Click to go directly to the device web page for General Settings.

r
Alarm Event Configuyation

Dasic Advancad |

Wideo Preview

Start Sirulation

| [ G to Wieb Interface

AT S SN
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Digital Input Event

Step 1: Click and highlight the Digital Input on the event type list and then click the E Insert Event icon.

Step 2: Select the device that is connected to your camera(s).

‘" Event and Action Configui

Event Action
W
-4 CAMOL D-Link DCS-2103 (192. Action Options
-G CAMO2 D-Link DCS-6210 (182.. | |
-4 CAMO3 DCS-37] cojoct Digital Input Module ﬁ

--[#] Digital Input/Oul

Digital Input/Output Event:

I/0 Module Pin Mame
D-Link DCS-2103 (... O Input 0 b
DCS-3715 ] Input 0

C

| (/o] [X conn )
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Action

Assign an Action Type

Insert Action: To configure actions responding to an unusual event.

~Event

I ERE R &

Action
& @@ @ @

-G CAMO1 D-Link DCS-2103 (192.:
gk CAMO2 D-Link DCS-6210 (1921
=45 CAMO3 DC! 523715

Action
[I]Dn Screen Display

Options

i 1.8] Generall Select Notification Action

=)

_[#] Digital Tnpu

Action Type
e Play Sound
B send E-Mail
% oypo

Description
Play wamning sound
Send E-mail to contacts

Popup DI/DO panel or trigger digi...

[«

oK ] [x Cancel ]

E .

[\/ oK ] [x Cancel]

Step 1: Select an event and click the D Insert Action icon.

Step 2: Select one of the three actions you want and then click OK.
1. Play Sound
2. Send E-mail
3. DI/DO

Step 3: Configure the setting of the Action Type if needed.
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Play Sound

The system will play the sound when an unusual event is detected.

Step 1: Select the Play Sound action and then click OK.

Step 2: The window below will appear. Select a Wave file ((wav) and then click the Play Sound indicator to modify the setting.

AR
B I&}wave j - i O EEE

|4 | Alarm] way
|9 | Alarm way
|9 | Do ghark.way
|4 | OldFhane way
|4 | Ringer way
|9 | Bivenl waw
|9 | Biven waw
|| Sirend e

-
AR _ERDSEEE
1A 1) | = EEo |
THFELRATY: I Wave Files (*wav) j i

D-Link D-ViewCam User Manual



Section 3 - Configuration

Send E-mail

The system will send an E-mail immediately to given accounts indicating the type of event, the time, and attaching a picture taken while the event
is detected.

Step 1: Select the Send E-mail action and then click OK.

Step 2: From the Select Contactor window select the email address(es) you want to send alerts to.

Marne | E-Mail Address \
AR xxxx HHENENHNA, COM
OF oo oOEN000neLCom
EditAddress Book « 0K ‘ X Cancel |

Edit Address Book: Click the Edit Address Book button to add, delete, or edit contacts.

Address Book |

Please inputthe name and contact information

Name:l Phone E-Mail |

Description: |

A | Clear ‘ Modify: | FEMLyE: ‘

Contact persons

[Marne \ Phone \ E-Mail \ Description |

o 0K X cancel
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DI/DO

Use to trigger Digital Input/Output devices that are connected to the camera(s), such as alarm lights and sirens.

DI/DO X
Digital output to signal:
1/ Module Fir Iarne
OCepartment 1] Cutput 0
Oo-link bcs-510... 0 Output 0
Oo-Link DCs-E62... 0 Output O
Oo-link DCs-523... 0 Output O

[ Autormnatically popup FQ control panel
l/ 0K l lx Cancel]

Step 1: Select the DI/DO action and then click OK.
Step 2: Select Digital Input Module and then click the “DI/DO” indicator to modify the setting.

Step 3: Select the device that is connected to your system, that is, the PC you are working with. You can enable the Automatically popup I/0 control
panel check box to obtain the correspondent panel to monitor the I/0 status.

You should adjust the setting of I/0 device in General Setting > Setting > System Setting > 1/0 Device first, the I/0 control panel will display the
device status based on it. You can also adjust the size of the panel by dragging a mouse or click the =180l on the right top of the display window.
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E-Map

E-Map

EE Bistra

E|- Device

L Cam3(192188.2.219)
L Cama (192168.2.213)
L@ cam32

&F Cam3(192.168.2.219)-Ir

Information

Cama3(192.168.2.219-0utput 0 (10}
state:OFF

4] | ¥ - N

With E-Map, users can track the actual location and alarm status easily for each camera and receive instant response when the event happens. The
arrows and lightening icon on E-Map represent cameras and 1/0 devices and these icons will turn red once they are triggered by alarms.

To launch E-Map application, simply click on Start and select Open E-Map from start menu to open E-Map window.

There are 2 modes in E-Map application:

Edit mode: Allow users to add/edit maps and indicators of devices. In Edit mode, the function buttons on the bottom of the window will be
active, and then setup the configuration before running E-map function at the first time.

Operate mode: All settings will be activated in this mode.
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Edit Mode

You will need to be in Edit Mode to activate the function buttons.

Device and Map

EIE Map

E-Map
2B Aot
L East
B Bistro

E| =l Device

L Cami

-2 Cam3(192168.2.219

> Camd (1921682213
. Camz

=
Cam3{192.166.2.21 9-Ir
3Cam -0
of Camé (192.168.2.21 31

Information

Bistro {Map)

I Add Map | Edit Map | Delete | Rotate |I

Function Buttons

W Gave

Edit mode/Operate mode
Switch button
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Add/Edit/Delete Map

Add E-Map

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Click the Add Map button to load a map image.

Step 3: Select the map file and insert the map name. Click OK, and then the map you added appears in the tree structure in the device and map

list.

Step 4: The map indicator appears on the left-up corner of parent map. Drag it to the position you want on the map.

Map Config

Map lmage File:

Map Mame:

=]

[8].8

|x Cancel |
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Edit E-Map
Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Right-click on the Map L} icon to obtain the option menu to edit map, or just click the Edit Map button to open the “Map Config” dialog.

Step 3: Modify the required details and then click OK to save configuration.

Delete E-Map

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Right-click on the Map B icon to open the option menu to delete map, or just click Delete to remove the map from the list.

Note: The root map cannot be deleted.

Add/Rotate/Delete Device Indicator

Add Indicator:

Step 1: Make sure you are in Edit Mode and all devices are connected.

Step 2: Select on the Map = icon which you want add device indicator to.

Step 3: Before adding indicator, ensure that the map you want is displayed. Select device from list and directly drag a device to the desired location
on the map.

Note: Different device is symbolized by different indicator.

' - Camera indicator ,jf - digital Input indicator
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Rotate Indicator

Step 1: Make sure you are in Edit Mode and all devices are connected. Select device indicator from map or form Device and Map list. The device

indicator will be marked with a green ring. L /

Step 2: Click the Rotate button, the indicator will rotate 45 degree.
Note: Only camera indicators are allowed to be rotated.

Delete Indicator

Step 1: Make sure you are in Edit Mode and all devices are connected. Select device indicator from map or form Device and Map list. The device

indicator will be marked with a green ring.  /

Step 2: Click the Delete button, the indicator will be gone.
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Operate Mode

. =B Airport
{0 L East
| BB Bistro

o & Device
2 carmt
* Cam3(192168.2.219)
Lo Camd (192 168.2.213)
2 Cam2 'S
y Cam3{192.168.2.219)-Ir
! 0

H} Cama(1

Infarmation

. )-II

LooF Camd (1 )
L0 Cam4 (182.168.2.213)-C Bistro (Map)
wr
4 | ]
Add Map | Edit hap | Delete ‘ Rotate o Eave

Device and Map Tree list

This window will list all devices and map hierarchies. Click the Device or Map indicator to show related information in the E-Map window.

Map

Select the map you want to show in the E-Map Window.

Camera

Select the camera you want to preview video from in the preview window.

Select to highlight the device with a green ring on the map and show its status in the Information window.
If the Digital Input is from an IP camera, the preview window will display live video from the camera.

Digital Output

B
2

Select to highlight the device with a green ring on the map and show its status on the Information window.
If the Digital Output is from an IP camera, the preview window will display live video from the camera.
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Layout Adjustment

E-Map

El = Device
e Caml
Lo ® Cam3(192.1658.2.219)

Information

amd

; Camd (192:1 68:2:213)-( Bistro (Map)
4| | _>| _/ r(l
Add hap | Edit Map | Delete | Fotate ,/ Saye
Adjust layout Window

Shrink the window:

Click the triangular indicators E= <l to hide the Device and Information windows on the right and left side. Click triangular indicator again to go
back to the default setting.

Full screen display:
For a computer system with dual monitors, you can view the Main Console on primary monitor and view the full-size E-Map on a secondary monitor.

Step 1: Click the triangular indicators = < to hide the Device and Information windows on the right and left side.

Step 2: Click on = located on the upper-right of the window to switch to full screen mode.
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Log Viewer

System Log I Export and Backup Log | Unusual Eventl

Log Type: All -
Date: [v 201410905 - 2] Exportto...
Date Time: |i— 201410905 16:00:07 » =1 to |i— 2014/09/05 16:09:07 * =] Search

Event Time | Event Type | Device | Description

To launch Log Viewer, Click on General Setting and select Log Viewer from the menu. View the unusual event history that had been detected by
the Smart Guard System.
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System Log

Select the Log Type from the drop-down menu. There are a total of 23 log types to choose from:

1. Main Console Startup 7.Execute Recycle

2. Main Console Shutdown 8. Enable Channel

3. User Login 9. Disable Channel

4. User Login Failed 10. Start Smart Guard

5. Start Schedule 11. Stop Smart Guard

6. Stop Schedule 12. Modify Smart Guard
[ Log Viewer

13.Modify Schedule

14. Modify Configuration
15. Start Live Streaming Server
16. Stop Live Streaming Server

17. Modify Live Streaming Server
18. Start Remote Playback Server

System Log I Export and Backup Log 1 Unusual E\tsml

Exportto

2014/09/05 12:11:11
2014/09/05 15:01:20

Modify Configuration
Start Schedule

Log Type: All o
| Date: [~ 2014100105 - 2
Date Time |["" 2014/09/05 16:11:04 = = 1o |["" 2014109105 16:11°04 * = Search
EventTime  |EventType | Device Description
2014/05/05 10:13:28 Main Console Startup
2014/09/05 10:13:38 Main Console Shutdown
2014/09/05 10:26:13 Main Console Startup
2014/09/05 10:52:21 Main Console Shutdown
2014/09/05 10:52:29 Main Console Startup
2014/09/05 10:53:08 User Login admin
2014/09/05 10:53:38 Modify Configuration
2014/09/05 11:32:15 Enable Channel i CAM1
2014/09/05 11:32:15 Enable Channel 2 cam2
2014/09/05 11:32:15 Enable Channel 3 CAM3
2014/09/05 11:32:15 Enable Channel 4 CcaM4
2014/09/05 11:32:18 Modify Configuration
2014/09/05 12:03:56 IP Camera Connection Lost : 172.17.5.31
2014/09/05 12:04:12 IP Camera Connection Regained 3 172.17.5:31
2014/09/05 12:08:55 Enable Channel 1 CAM1
2014/09/05 12:08:55 Enable Channel 2 CcAM2
2014/05/05 12:08:58 Modify Configuration
2014/09/05 12:08:59 IP Camera Connection Lost 1 192.168.0.12
I 2014/09/05 12:10:02 IP Camera Connection Regained 1 192.168.0.12
2014/09/05 12:11:07 Enable Channel 3 camM3

i

m

19. Stop Remote Playback Server
20. Modify Remote Playback Server
21.IP Camera Connection Lost

22. Auto Restart Windows

23. Modify E-Map

Step 1: Select the type of event you want to check or select All from the drop-down menu for all types of events.

Step 2: View the events that happened on a particular date or during a given time period by selecting a search period.

For a particular data: Check the “Date” box and select the date you want to view.

For a period: Check the “Date&Time” box and then enter the date and time.

Step 3: Click Search.
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Export and Backup Log
View the Export and Backup Log history that had been operated by local or remote user.

Step 1: Choose the type of event you want to check or select All from the drop-down menu for all types of events.
Step 2: View the events that happened on a particular date or during a given time period by selecting search period.
For a particular data: check the Date box right and indicate the date.

For a period: check the Date Time and then enter the date and time.

Step 3: Click Search

System Log Exportand Backup Log | Unusual Event'

Log Type: INI j
Date: [« 2014100105 - 2] Exportto...
Date Time: |I— 2014/09/0515:12:29 ~ j} to |[— 2014/09/05 15:12:29 ~ j} Search

Event Time | Event Type | Success | Username | Start Time | End Time
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Unusual Event

System Logi Export and Backup Log Unusual Event ’

Log Type: All -

Channel: All -

Date: [« 201400105 - 2 Exportto...
Date Time: [ 20140005 160957 - 21 1o [[7 2014109105 16:00:57 ~ 2 Search

Event Time | Event Type | Camera I Description |

Step 1: Select the type of event you wish to view or select All from the drop-down menu to view all types of events. The types include General
Motion, and Signal Lost.

Step 2: Select the camera channel you wish to view or select All for all available channels.
Step 3: View the events that happened on a particular date or during a given time period by selecting a search period.

For a particular data: Check the “Date” box and select the date you want to view.
For a period: Check the “Date&Time” box and then enter the date and time.

Step 4: Click Search.
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Export

After you search the log you want, you can export it to an Excel (.xls) or a text (.txt) file.

Step 1:

Step 2:

.+ Log Viewer

Systemn Log | Export and Backup Log | Unusual Event'

Log Type: IA.II j
| Date: [+ 2014109005 - 2] Exportto... |
Date Time: “— 2014/09/05 16:11:04 = j' to “— 2014/09/05 16:11:04 - j: Search |
Event Time | Event Type | Device Description
2014/09/05 10:13:28 Main Console Startup
2014/09/05 10:13:38 Main Console Shutdown
2014/09/05 10:26:13 Main Console Startup
2014/09/05 10:52:21 Main Console Shutdown
2014/09/05 10:52:29 Main Console Startup
2014/09/05 10:53:08 User Login admin
2014/09/05 10:53:38 Modify Configuration
2014/09/05 11:32:15 Enable Channel 1 CAM1
2014/09/05 11:32:15 Enable Channel 2 CAMZ
2014/09/05 11:32:15 Enable Channel 3 CAM3
2014/09/05 11:32:15 Enable Channel 4 CAM4
2014/09/05 11:32:18 Modify Configuration
2014/09/05 12:03:56 IP Camera Connection Lost 3 17217531
2014/09/05 12:04:12 IP Camera Connection Regained 3 172.17.531
2014/09/05 12:08:55 Enable Channel 1 CAM1
2014/09/05 12:08:55 Enable Channel 2 CAMZ
2014/09/05 12:08:58 Modify Configuration
2014/09/05 12:08:59 IP Camera Connection Lost 1 192.168.0.12
” 2014/09/05 12:10:02 IP Camera Connection Regained 1 192.168.0.12
2014/09/05 12:11:07 Enable Channel 3 CAM3

2014/09/05 12:11:11
2014/09/05 15:01:20

Modify Configuration
Start Schedule

|

I

Click the Export To button.

Type the file name and select the file format (.xls or .txt).
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Backup

The backup function saves video records and other log information.

S Backup  Help

o . 0O L .
@ P Mesw Period \L.A?Remuve Period @Backup % | Delete

| End Date Time | Camerafs)
2009/5/14 FF [ 1,2,2,4
2009/5(15 4 10:46:00 1,3

111,1285KE

Note: The backup cannot exceed 7 days of recordings.
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Back up Recorded File(s)

yaterm [Localhost]
© Backup  Help
4 - & . )
@ Mt /.)New Period Rermove Period Backup Delete
Start Diate Time | End Date Time | Comerafs) Size |

f{
Step 1: Click the Remote Sever icon L*{:j to add and set up the backup.
« Enter the IP address or DNS, Port, Username, and Password.

« Click Add to add the server.
+ Click OK to exit the Setting panel.

Step 2: To access the Remote Backup Site, click on the @ - icon and enter the username/password
of the remote server to access the backup site.

Step 3: Click on New Period to open the Select DateTime Period panel.

Step 4: Select the data you want to back up by highlighting the time period. You may also set up a
start and end time in the Date Time Period section.

Remote Backup Sits M e e

~Server Setting

Server Name:

Address:

Faort:

User Mame

Password:

[~ Save Password:

Test Server

58 Iocalhost {localhost)

Add | DE(Ete ‘ Update ‘

v 0K | x Cance\|
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@ [ p-Link bcs-2103 | T T 7 » T - * T + eei‘
@ M p-Link Des-6210 | Tl
@ @ opcsaris 1
@ Bomeas
@ B comeras
@ B cmero
Q@ [EHcmern7
/?Ecame’?a /*.' Llj
.Always Record — Video Overlap
[l Record on Motion ~ 0K X cancel
—_ rB&ckup @1
Step 5: Click on the camera number icon to add camera(s) or click ﬂ to add/delete T
all channels. Total backup data size: 264,602KB
. . . . Media
Step 6: Check the Enable Preview box to display the preview of the video you selected. _
(~ Backup using CDROM
. . ¢~ Backup using DVD
Step 7: Click OK when the settings are complete. B i
. . . . =
Step 8: If there is a data period you do not want, click Remove Period to remove the data
period from the backup list. Option
[~ Backup Event Log
Step 9: Click the Backup icon to open the Backup panel. I Backup System Log

@y DateTime Search Dialog [Localhost]

.

#2300

Event Color Display Settings

Video Preview
[ Enable Preview

Ll ALA 2014 1> Color Event Type

3112 3 4[5 6 2 ,’:
»| 7 B 910111213
=14 15 16 17 18 19 20
=|21 22 23 24 25 26 27
(282930 1 2 3 4
| 567 8 91011

I Show Recording Schedule

I™ Show EventLog

Start Time: 20140005 = |00-00:00 = EndTime
5

~ General Motion
Signal Lost

20140905 = |00:00:00 =

(@ += owosls 1 2 3 4

Step 10: Under Media, select the path you want to save the file or burn the file directly to a
CD (direct CD burning for Windows™ XP only), DVD or to a hard drive.

Step 11: Under Option, select the log information you would like to back up (Event Log or

System Log,), and then click OK.

Note: The backup cannot exceed 7 days of recordings.

| [ Include Playback application

e

oK ‘ X Cancel|
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Delete Recorded File(s)

Step 1: Click on New Period to open the Select Date Time Period panel.

: Backup Help

: - N
k.’_)lj 5 ,,)New Period \;\?Remove Period @ Backup | % | Delete
Start Date Time | End Date Time | Camerals) | Size |

+2009/5/14 FF 01:09:00 2009/5/14 F<F 01:32:00 1,2,3,4
jZUUQ#SIlS L4 103300 2009/5/15 E4F 10:46:00 1.3

Step 2: Follow steps 3-7 from the previous two pages to select the data period which you want to delete.

Step 3: Click on the Delete icon to remove all the data in the backup list from the database.

Note: The deleted video cannot be recovered.
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Remote Live Viewer

With the Remote Live Viewer software, remote users may watch one real-time video channel per server from up to 64 remote live streaming servers.

D-Link D-ViewCam User Manual 100



Section 3 - Configuration

Setting

Click the General Setting icon to open settings dialog window.

© @@

General Setting

General | server | Group | Camera | 0D | Monitor Display | Notiication I

Audio preview

I Enable audio on active channel

Miscellaneous

I~ Synchronize video frames

-~ Startup
™ Full Screen

v Ok | [X Cancel ]

Audio Preview
Enable audio on active channel: Select it to enable the audio streaming on active channel.

Miscellaneous
Select to prevent tearing that may occur in the video display. However, this will increase the CPU processing load.
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Server Settings

General  Sever | Group | Camera | OSD | Monitor Display | Notineation |
Server Setfing

Q Server Name:- [ T i test (127.0.0.1)

Address: |

Port |5150
User Mame: |

Password: |
Save Password ™
Auto Login: ™

Test Senver

| [ Deteta | [

Step 1: Enter the Server Name as preference.

Step 2: Enter the IP address, Port, User Name, Password to log in the server.

Step 3: Enable the Save Password to login without entering the password again.

Step 4: Enable the Auto Login to login automatically when starting the Remote Live Viewer.
Step 5: Click Test Server to check if the server is available.

Step 6: Click Add to insert the setting to server list.

Note: To remove the server, select a server on the server list and then click Delete.
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Group Setting

Allocate different cameras into groups.

General ] Server  Group l Camera ] 0sD ] Monitor Display | Motification

SiTnsert B Delete 9§ Rename & Login

==

-8 New Group

Step 1: Login to all the servers that contain the camera(s) you would like to put into the group(s).
Step 2: Click Insert to create and name a new group.

Step 3: From the window at the right, highlight the camera that you would like to add to a group and then click on the <-- button. Repeat the
process until all the cameras you want in the group are added.

Step 4: Click on the Delete button to remove a specific group or click the Rename button to change the name of a specific group.

Step 5: Click OK to save your group.
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Camera Setting

General I Sewer} Group  Camera IDSD 1 Monitor Display | NMofification I
Select the preferred stream type of each camera as default live view profile S

. . Layout type: ’m
Stream profile: Select a layout type and choose which stream profile you would like to ’ =
apply on this layout. steam pofs 2
For some layout with large and small grid, you are able to assign different stream profile. .
Resolution: i

Record 1: The system will follow the stream profile set in main console > Schedule > - i
Encoding Options. e -
Record 2: The system will follow the stream profile set in main console > Schedule >
Encoding Options.
Main / High / Normal / Low/ Minimum / H.264: The system will follow the stream profile
set in main console
- Setting - Camera - Stream Profile.
Apply to All Layout: Apply the stream profile setting of current layout to the other layouts.
Copy to: Select in order to copy the preferred stream profile of a channel to all of the listed
channels
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OSD Setting

Select the font style and colors of information displayed on the video.

| LiveView Setting
General] Sewer] Gmup] Camera 0SD annitnrDisplay] Motification I
v Enable camera OS50
Foreground-
Font % Tahoma |
Size: g -
v Bold v Edge
Background
Transparency: | 40
Info i
v CameraMame
[~ Date 12014/09/05  ~ | :
[~ Time FF042514 ~| l
[~ Bitrate
| |
| Defaul S
v 0K |x Cancel
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Monitor Display Setting

Activate auto scan to rotate the channels/cameras on screen. For instance, you may select to show only 4 sub-screens on the live viewer while
having 16 channels connected to the system.

General ] Server] Group ] Camera | 0SD  Monitor Display ] Mofification ]

Monitor | Resolution
#1 1366 x 768 Auto scan

Auto scan group: All Camera 5
Primary channel: (Mot Used) -
Secondary channel: (Mot Used) -
Auto scan interval: 12 sec.

Layout
MxM type:

Step 1: Select the Monitor connected to the system.

Step 2: From the Auto scan group drop-down, select a group.

Step 3: Select a primary channel that will always be on the screen when activating auto scan settings.

Step 4: Select a channel that has secondary priority then primary channel on the screen when activating auto scan settings.

Step 5: From the Layout drop-down, select the screen division you want displayed.
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Notification Settings
Status display

Show recording status: Check to show the crystal ball with recording status on
monitor display.

Show camera event: Check to show the smart guard detected event appointed in
main console on each channel.

Note: To execute this function, please General Setting “on screen display”as an action
of Smart Guard instant response.

Switch live view layout to 1x1: Check to switch the display layout to 1x1 when smart
guard detected event appointed in Mainconsole on each channel.

Play sound alert: Enable playing sound on event: Check to enable sound alerts on
events.

Sound File: Choose a sound file to play. You may use the default file or define another.

Life Cycle: Choose to allow the sound alert to close when events disappear, or define
a timer to close the sound alert automatically after a specific period of time.

Note: To execute this function, please General Setting “play sound” as an action of
Smart Guard instant response.

General | Server | Group | Camera | 0SD | Monitor Display ~Nofification

Status display
[~ Show recording status
I~ Show event message on screen
|

~Play Sound alert
¥ Enable playing sound on event

Sound File
+ Default

" User defined wave file

Life Cycle
+ Automatic cancel sound alert when event disappear

" Stop sound alert after 10 Sec.
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Server/Group/Camera

Display a complete list of the server(s), group(s), and camera(s) that are added to the system.

Server View: Click icon to display cameras sorted by servers.

L
roup View: Click ksdtstted icon to display cameras sorted by group names.

El-- EIIEJJ Mew Group
--af» D-Link DCS-3714 (1 - DLink DC5-3714 (1
q]“]. D-Link DCS-942L (1 I]“} D-Link DCS-9421 (1
‘..q]f» D-Link DCS-5222L { ‘ol DLink DCS-52221 {
4 T ¥ L I k
Server View Group View
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Login/Logout Server

Option 1: Select a server on the list and then click on the i Log In icon to

access or the i Log Out icon to leave the server.

Option 2: On the server list, right-click to open the menu options.

Connect/Disconnect Camera

Option 1: On the server/camera list, double-click on a camera to connect it.

Option 2: On the server/camera list, right-click on a camera to open the menu options
to connect/disconnect it.

Connect

Disconnect

Login Server

Logout Server
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Option 3: Select a camera from the list and drag it to where you want the image to be displayed.

DC5 6210 {192.168.0.11)

92.168.0.11) i ,Q\ . Eﬂ@@ @
mily" |

=

- DLink DCS-2103 (1

D Link DCS-6210

L. DC5-3715_1
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PTZ Control

Control the movement of PTZ cameras. With cameras that support PTZ control, you can move, zoom, patrol, adjust the focus, and set preset points
of the cameras.

Add Preset Point/Go to Preset Point

Adjust the camera view and click on the Set icon and save the view as preset point 01. Adjust the camera view again and set up the preset point 02.
Repeat the process until finish setting up all preset points. Enter any names you want instead of the preset point 01, preset point 02, preset point
03..., click on the Go icon to view the preset points.

Note: To change the speed settings of your PTZ camera, click on Main Console > General Setting > Setting > System Setting > PTZ Config.
Auto Pan

Go to Go to Preset Point and click on Start AutoPan to enable auto pan. Click on Stop AutoPan to stop.
Auto Pan enables the camera to scan an area horizontally from left to right or right to left.

Zoom

Click on the + (Zoom Tele) and - signs (Zoom Wide) to zoom in and zoom out the view.

Patrol

To have your PTZ camera patrol around pre-defined path of preset points, click on the Go to Preset Point icon in the Main Console, and select Start
Patrol or Stop Patrol to start/stop the patrol.

To set up a patrol path, go to Add Preset Point > Set Patrol to bring up the Patrol Setup dialog. From the left window, select the camera(s) that you
would like to have in the patrol group. Align the cameras in order in the right window and adjust the time. Rename the group name if you want.
After completing the setup, check the Active option, and then click OK.

Focus

To focus near means objects that are closer will be clearer than the objects that are further away. On contrast, to focus far means objects that are
further will be clearer than the objects that are closer. Click on the Focus icon and select auto focus if you want the system to decide the focus
point for you.
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On Screen Menu

Right-click on the camera screen and get the “On Screen Menu’, from which you can quickly
adjust the setting of camera.

Enable Talk
With cameras that support two-way audio, select Enable Talk to utilize the function

Enable Audio
Select this option to enable the audio transmission along with video stream

Enable Move

With cameras that support PT function, click the Enable Move function to adjust the current
camera’s view by clicking on the display screen. To cancel this function, right Click the screen
and select Disable Move. With cameras that support Area Zoom function, click the Enable
Move/Area Zoom function to adjust the current camera’s view by dragging a rectangle on
the display screen. To cancel this function, right Click the screen and select Disable Move/
Area Zoom.

Fix Aspect Ratio
For some special camera resolution, user can enable Fix Aspect Ratio to view original ratio
video, or disable this option to stretch 3:4 to fit window.

Stream Profile
Select different level Stream Profiles to downgrade video quality for bandwidth concerns.

Snapshot
The snapshot function captures a specific video image to the clipboard or to a file you can
save to your computer.

Toggle Fullscreen

Switch to view video with full screen display. To disable the function, right-click on screen and
uncheck this option or simply press ESC to go back to original window.

| Enable Talk
Enable Audio

Fix Aspect Ratio

Snapshot
Snapshot from Main profile

Toaggle Fullscreen

R—

Record 1

"

Record 2

Main
High
Nomal
Low
Minimum
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Playback

Select to open the Playback panel and view video remotely.

Add Remote Playback Site

. Ffl Eemote Plavback Site Management
Click the Remote Sever icon Lf:j can go to remote playback site management to add and - erver Satiing
setup the remote playback site. 9 severbame: [
Address: I

Step 1: Enter the IP address or DNS, Port, Username, and Password. pot [0
User Mame: l—

Step 2: Click Add to add the server. —

Save Password: [~
Step 3: Click OK to exit the Setting panel. TectSomver
Add | [ElETE | Uhdate |

Access Remote Playback Site
v 0K | X Cancel|

Go to Date/Time Panel and click on the @ " icon on the top of the display window to access the Remote Playback Site

¢[® QW00
Local Machine

Remote Server 1 {192.165.1.51)
Remote Server 2 {192.163.1.52)

==

13 14 15 16 17 15 19
20 21 22 23 24 25 26
£F 28 29 30 31
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Start Monitor

Cpen E-Map
Open LD Control Panel

E-Map

Select Open E-Map to open the E-Map window.

Map Select the map you want to show on E-Map Window.

Camera

Select the camera you want to preview video and mark an indicator on E-map.

Digital Input

Select to highlight the device with a green ring on the map and show status on the Information window. If
the Digital Input is from an IP camera, the preview window will display live video from the camera.

&
2
.

.H:-t Digital Output

Select to highlight the device with a green ring on the map and show status on the Information window. If
the Digital Output is from an IP camera, the preview window will display live video from the camera.

1/0 Control
Select to open the I/0 control panel. The panel allows you to control DO devices remotely.

Note: Adjust the setting of I/O device in Main Console > General Setting > Setting > System Setting > 1/0
Device first, the I/0 control panel will display the device status base on it.

- I0 Devices Q@
Servars [lacalhost v Show name:
—ol
o o
Input 0 Input 0
—Do
@) @)
Qutput 0 OQutput 0
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Web View

With the Web-based Remote Live Viewer, remote users may watch one real-time video channel per server from up to 64 remote live streaming servers.

Remote Live Viewer

D-ViewCam

Remote Playback
—#— =

Bullding Metworks for People

Note: Make sure the Live Stream Server is enabled.

D-Link D-ViewCam User Manual 115



Section 3 - Configuration

Server IP

Open Internet Explorer and enter the IP address or DDNS “name” of the server followed by the connecting port.
Example: http://192.168.1.16:8080/

Note: 192.168.1.16 is the IP address of the server.
8080 is the port specified in “Use Default Web Server”in Network Service.

Remote Live Viewer

Click this icon to use Remote Live Viewelr,.

Remote Playback

Click this icon to use Remote Playback.
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Utilities
Verification Tool

The Verification Tool verifies whether the data created by the system be tampered with or not. It is the process by which a digital watermark (a
digital signature) is added to each recorded video frame to ensure its authenticity.

The 3 types of data that is verified by the Verification Tool are:
1. File in (.dat) (.264) format will be displayed as #* .

2. File in (.avi) (.asf) format will be displayed as i

3. File in (.bmp) (.jpg) format will be displayed as O )

. D-Link D-ViewCam
] Backup System
Step 1: Go to Start > All Programs > D-Link D-ViewCam > Verification Tool. kd DBTools

% Main Console

Playback System

Remote Live Viewer

& Uninstall D-Link D-ViewCam Syste

Eﬂ Verification Tools

L1

Step 2: Enter the Username and Password to log in.

Login Verification Tool

Flease enter password far the administrator of Main Consale ;

Lser Mame: Iadmin

Password: ||

(0] 4 Cancel
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Overview

B Verification

EY=NE

W aterrnark

File: Marne

Start Time

2009/05]

End Time
200905

Zam Mame
D-Link O, ..

Path

C:Docurnents and S

Wideo Preview

< | >

Status Werify |
Murmber of Verified Files : 0 files Time elapsed : oo oo ooo
Mumber of Passed Files ; 0 files Tirme left: 0o oo 0on

gAdd File: Click to insert a file to the list for verification.

'-IEAdd Folder: Click to choose a folder with multiple files and then add it to the list for verification.
|1 Remove File: Click to remove the selected file(s) from list.

& Select All: Click to select all the files in the list for verification.

s 1IN
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Video Preview: To preview the selected file from the verification list. Use Play, Verify, Pause and Stop for preview.

Note: Preview of .omp and .jpg formats are not allowed.

Verifying Image/Video

Step 1: Select a single or multiple files for verification.

Step 2: Click verify ‘ to start verification.

Step 3: The verification results will be displayed in the Watermark column.
Note: If the file passes the verification, it will show {:f"}

Note: If the file was tampered with, it will show ”

B Verification E ‘E‘ |

3103 [k D _video Preview
File Mame  ||Watermark || Start Time | End Time | Cam Mame | Path Eil

@7 C00002,.. 2009/05f,.. 2009/05/... D-Link DC... C\Documents an

w004 S, & 2009/06f,,, 2009/08/.., D-LinkDC... C\Documents anc

#0604 _sa.. @ 2009/06f... =2009/08/... D-LinkDC.. C:\Documents anc

$7C00001... & 2009/05f.. 2009/05/.. D-LnkDC..  ci\Documents anc

7 C00001.., & 2009/05f... 2009405/, D-UMkDC..  ci\bocuments anc

¥ 2009/05f,.. 2009/05{.., D-LinkDC... C:\Documents an
@ 00002, .. 2009/05f... 2009/05f{... D-lLink DC... C\Documents anc
@7 C00002... 2009/05f... 2009/05/... D Llnk DC.. C 1.‘Documents anc
e A e Ll_l
> & 01N
Mumhber of file Wetrified : 7 files Time elapsed : 00:08: 266
Mumber of file Passed : 7 files Time left: 01:49:380

Step 4: The Status and Verify fields will display the information related to verification.
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DB Tools

Step 1: Execute DB Tools from the Start menu.

. D-Link D-ViewCam
] Backup System =
kd DBTools
¥ Main Consale
Playback System
Remote Live Viewer
& Uninstall D-Link D-ViewCam Syste
[4] verification Tools

m

Step 2: Enter the administrator password and click OK to log in.

DETools login ﬁ

Please enter password for the administrator of Main Console :

Username: |admin

Password: ||

ook | | come
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Repair Database

'|I;his ;?agDe tha; three repair methods: Modify Location, Verify Only, and Repair Index and o |Mndiﬁf Location j
epair Latabase. Modify Location
Ctart Werify Only
Modify Location Repair Index

Playback system can recognize all recording video in the folders which list on Main Console >
Config > Setting > General page. For some reason, users need to use the Playback system to
open recording video beyond storage location setting.

Repair Database

arid o o o PR T ——

Note: The default storage location is in your installation directory.

Step 1: Select Modify Location from the Method drop-down menu.

Step 2: Click on the “ button and select a new location. video Fie Locations

C:yProgram Files\D-LinkiD-ViewCam

To remove a database location, select it from the list and click on the # button to
delete location.

Step 3: Clickon the MOdify button to save the location. Modify Result 2 locations confirmed.

Open Log l [ todify
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Example of modify database

In certain cases that video data needs to be transfered from one PC to another, you will need to perform the following procedure:

1. Manually copy all recorded video data files from the default installation path or other user-defined storage path of the old PC.

T
3 C4Program FilesHUUOISCE_IP
x | 5 = g

. == = .
i [ IBM ~ L/ d '_.J
[ [BM ThinkVantage 20060321 20060323 niaral
F |5 Installhield Installation Inf
& () Ikl o e
& £y Intemet Explarer ;_J E
& 3 Koei .
B 5 Lenovo wave s ] 3gpp.dll

2. Manually paste all recorded video files to the default installation path or other user-defined storage path of the new PC.
3. Follow previous page to add new location on new PC.

4. Old recorded video data can be viewed by playback system on the new PC.

For verify and repair proposes:

This tool is used to check and repair your database and recording video with below problems:

(1) If there are records in database, but no video file, use DB Tools to delete records.
(2) If there are video files but no record in database, use DB Tools to rearrange the database and find these records.
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Step 1: Switch to Repair Database.

Step 2: Check the video location windows. The system will list all video locations in table, but if there are any omit, please use = toinsert. After
inserting location, the system will show a file count table.

File Count; 41

Step 3: Select Verify Only and then click Verify. This method will only check the files without modify. Verify result will show how many files broken
or missing.

WVearify Result: 41 files werified, 0 files bhraken, 0 files missing.
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Step 4: Choose the method of “Repair (Complete)”, and click “Repair” to repair. The Repair Result will show how many files are fixed and inserted.

Fepair Result: 2 files fixed, 41 files inserted.

Step 5: :The repair new database will replace old ones. And the original database will change file names with extend repair date and time.

Note: Open Log is a tool to record repair database recodes. It will recode repair method, file operation, strat time and end time.

& dbtool. log - Notepad E]@

File Edit Format Yiew Help

Operation "verify only" is started at (2008/07/14 12:01:17)

File Broken: D:\Vvideo/20080708/c00002/C00002500A20080708112323437.dat
File Broken: D:\Video/20080708/c00002/c00002500A20080708114304625.dat
41 files verified, 2 files broken, 0 files missing.

Operation "Verify only" is finished at (2008/07/14 12:01:19)

Operation "Verify only" is started at (2008/07/14 12:13:19)

File Broken: D:\Video/20080708/c00002/c00002500A20080708112323437 .dat
File Broken: D:\Vvideo/20080708/c00002/c00002500A20080708114304625.dat
41 files verified, 2 files broken, 0 files missing.

Operation "verify only" is finished at (2008/07/14 12:13:20)

Operation "Repair (Complete)” 1is started at (2008/07/14 12:13:58)

File Repaired: D:\Video/20080708/c00002/c00002s00A20080708112323437.dat
File Repaired: D:\Video/20080708/c00002/c00002s00A20080708114304625.dat
2 files fixed, 41 files inserted.

Operation "Repair (Complete)” is finished at (2008/07/14 12:14:07)

&) I (2]

D-Link D-ViewCam User Manual 124



Section 4 - FAQs

1. D-ViewCam software supported languages

Frequently Asked Questions

Albania Bulgarian Chinese (Simplified ) Chinese (Traditional)  |Croatian
Czech Danish Dutch English Farsi
Finnish French German Hebrew Hungarian
Italian Japanese Korean Norwegian Polish
Portuguese (Brazil) Portuguese (Portugal) Romanian Russian Serbian
Slovak Slovenian Spanish Swedish Thai
Turkish

2.How do | set up E-Map?

Please go to <Main Console>-<Start> and then click on <E-map>

Step 1: Click on <Map>

Step 2: Click on <Browser/ Edit Mode>
Step 3: Click on <Add Map>
Step 4: Choose a map and then fill in the map name

Start Monitor 2l
Start Recording Schedule
Start Srnart Guard System

Open E-Map

Open If0 Control Panel

Lock System
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- = Davice

|

Oepartrent
b O-Link DCS-B100 {192.163.
DO-LInk DCE-1100 (192168,
b D-Link DC5-B6200 (19216
O-Link DCE-5230 (192168,
t O-Link DCS-5610 (192168,
O-Link DCE-6100 (192168,
t O-Link DCS-3710 (192163,
=7 Department-Input 0
5 Department-Inpui 1
" DEpartrment-Duiput 0
2% D-Link DCS-6100 {19168,
:'H'! O-Link DCE-B100 (192 168 .
= D-Link DCS-BE200G (19216
‘gt D-Link DCB-BE20G (192,16 w»

3— 34

L

fdd Map i | Edit Map

Il rrd e File:

MWlap Mame:

[-./ [l ] Ix Cancal I

[UEERUE ]

Step 5: Click on the map you set
Step 6: Draw the camera or 10 device to the map
Step 7: Click on <OK> to save this setting

5. &

- Dawce

L Department

D-Link DCS-E100 {192 163

L D-Link DCE-1100 (192163,
O-Link DCS-B6200 (192 16

L O-Link DCE-5230 (192163,
DO-Link DC8-5610 {192 168

L O-Link DCE-E100 (192 163,
D-Link DC8-3710 {192 1 68

& Departmanl-Ipu1 0

= Departrent-Input 1

gt Departrment- QUIpUL 0

57 D-Link DC8-B100 {192 163

‘gt D-Link DCB-6100 (192,163

T T T e Tk T T T

L P O i A (LT
| ¥

(e
r E
==
z %
Dl e ]| Rutate i

D-Link DC5-5230 [192.168. 0.64) (Camera)
Signal Lost

v Sare |
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3. How do | back up video files?

User can backup any period of video record into VCD or other drive location, and view those video via playback.exe which

will also be saved in the backup folder.

Please follow those steps to backup your video record:
Step 1: Go to [General Setting] -> [Backup]

Step 2: Click on [New Period]

Step 3: Set start and end time for time period
Step 4: Select the cameras that will be backed up

Step 5: Click [OK] and the backup period will be set.

Setting k
Save/Load Configuration 2
B Log Viewer

orcwr

MNetwork Service

About Main Console...

[F] Backup System [Localhost] E‘%
Backup Help
@ - pNew Period Remove Period Backup Delete
Start Date Time  [New Period)d Date Time Camera(s) Size
[, DateTime Search Dialog [Localhost .g
ﬁ J @ 0 Date Time Period Video Preview
Start Time: 2012011127 + 15:54:22 + ¥ Enable Preview
4 November2012  »
SMTWTFS End Time 2012111/27% 15:54:22 %
(28203031 1 2 3
= 45678910 Set

#/111213141516 17
<1819 20 21 22 23 24
=25 26[27]28 29 30 1
% 2345678

-
-

Colar

| Event Type |

=
-

General Motion
Signal Lost

=

i 0-Link DCS-52
5 camera 2

{5 camera 3

i camera 4

fH camera 5

5 camera 6

fH camera 7

fH camera 8

o —r—

L&
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Step 6: Click [backup]

Step 7: Choose a location to backup media

Step 8: Set option to backup log files.

Step 9: Click [OK] to execute backup

Step 10: After backup, you can execute the playback.exe

to check the backup files

Sart Dabe Time Erd Dt Times T Camerals)
1 16 FM 2007 59542 PM \

Backup

—Bummary
Total hackup data size: 52,826KB

—Media
" Backup using COROM
= Backup using DVD

ID:I

ﬂ?ptinn

v Backup Event Log

v Backup System Log

\_

0K | X Cancel‘
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Backup Video Database...

Rebuilding database and copy required video Files
Backup from 2010/2/8 PM 06:10: 15 ko 2010/2/8 PM 06:11:00

CLLT] ][ Zancel J

\ ? ) Backup is completed, Do wou wank ko execute viewer?
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4. How do | enable audio in live streaming for IP cameras?

In order to save bandwidth, the default setting for audio is disabled, user needs to enable this function manually, please

follow those steps.

Step 1: Go to [Config] ---> [Setting] ---> [System Setting] --->
[General] and enable [Preview Active Channel]

Step 2: Default channel sets the backround audio of the selected

camera channel

Step 3: Switch Audio Channel

When choosing sub-screen 1, you will hear audio from camera 1
When choosing sub-screen 2, you will hear audio from camera 2
If you don’t choose any sub-screeen, you will hear the audio of the

default channel.

il Seiting

Gamera | 110 Device | PTZ Gonfig | Hotline | Address Book | Monitor Display |

Stariup

I™ Wain Congole

I~ Gehedule Recording System
I™ Sman Guard Systern

I~ Live Streaming Senver

™ Remote Playback Server

Storage

Loration EE

C:\Program Files\D-Link\D-ViewCam

Status Display
W Current Date

¥ Current Time

W Login User

[ Free Disk Space
W IP Camera Bitrate

™ Full Screen
Auto L [ User Defined Text1
AT Automatic Recycle
& Recycle when disk space is
less than 10 kY ™ User Defined Text 2
 Only keep videa for days
Log Recycling
Miscellaneous Audio Preview
™ Automatically popup event report Default Channel NotUsedy -
| Minaee e tain g W bl A B A Ehane
[~ Synchronize video frarmes
Volume 7)7
v o

’

CAM1 D-Link DCS-3714 (172.17.5.76)

OREREEEN

D-Link D-ViewCam User Manual

130



Section 4 - FAQs

5. How do | record audio for IP cameras?

Step 1: Execute Main Console and go to

[Schedule] -> [Configure] -> enable [Record Audio] -> [OK]
Step 2: Start Recording Schedule [Start] -> [Start Recording
Schedule]

6. How do | change the recording frame rate and the
resolution for IP cameras?

The recording frame rate and resolution are the same with live
video, please follow those steps for adjustment.

Step 1: Open up Main Console and go to

[General Setting] -> [Setting] -> [System Setting] ->
[Camera]

Step 2: Select the camera of which you want to change the
frame rate

Video Preview

Option

[ RecordAudio

[~ Keep key frame only
*Video profile frame rate: M/A

*The actual fps depends on camera
streaming capability.

Wiew in Real Size

General Camera | 10 Desice | PTZ Config | Hotiine | Address Book | Monitor Display |

Pk &
[ & cAMD1 test

Camera Settings

| . ol ———! I-_._

|:eg

q Camera Setings

[ sweamprome

Go fo Web Interface

L
[_ Lens Sefting
|

Video Parameter

snnv:i.'u;a;-lmos
I Date [201ai0005 =]
) I~ Time ,W‘
= W Camera Number
¥ Camera Name
I Birate
ApplyAll | | Font

(X cea
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Step 3: Click on [Camera settings]. You can change the
frame rate, resolution etc.

7. How do | set multiple storage paths for video recording?

Set camera stream quality
-

(This camera doesn't support Multi-stream.)
» Camera:D-Link DCS-942L (172.17.5.31)

Image Quality

Video Format  MJPEG  MPEG4 & H264

Frame rate 30

Resaolution 640x480 ot

Bitrate Mode: Constantbitrate  ~

Bitrate: 2048 -
—

Image Adjustment

[ Enable Flip

I~ Enable Mirror
Audio

[¥ Enable Microphone

v Enable Speaker

«  OK X Cancel

Our Main Console allows you to set up several hard disk drives as the storage location. When the first hard disk is almost full
(the capacity is less than 800 MB on system disks or 100 MB on non-system disks), Main Console will try to find a second

storage with enough capacity.

If no more capacity is available, Main Console will start recycling if auto-recycling is enabled.

If auto-recycling is not enabled, recording will stop.

Please go to [General Setting] -> [Setting] -> [System Setting] -> [General] -> [Storage Location] to modify your settings.
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General | camera | U0 Device | PTZ Config | Holline | Address Baok | Monitor Display |

Startup 1nraq.e Status Display
™ Main Console Location [:rTL_*_; W Current Date
[ Schedule Recording System C:\Program Fles (xB6)\D-Link\D-ViewCam % Current Time
[T Sman Guard Syslem

™ Live Streaming Server
[T Remote Playback Server
[T Full Screen ™ P Camera B

™ Aulo Lock System ™ UsarDafined Texd 1
™ Aute Login

W Login User
i Free Disk Space

Recyde Selup: [
I UserDefined Text 2

Video Recycling

Log Recyding

Miscallanaous Audio Previaw Auto Reboot

™ Automatically popup event report Default Channel I[N.M Usad) = I~ Enabie Auto Reboot

™ Minimize to system tray
[T Enable Audio on Active Channgl
™ Synchronize video frames

Volume

8. Why do | get “Disk space is low and the scheduler has been Error =
shut down. Please check the storage location setting to

/4 —
recover”? i  Disk space is low and the scheduler has been shut down,
Pleae check storage location setting to recover,

The error means recycling is not working, please follow the
steps to diagnose this problem.
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Step 1: check the setting and configuration

Make sure the auto recycle option is enabled in Mainconsole setting.

Make sure auto login, auto startup of Mainconsole and schedule are enabled in Mainconsole setting.

Remove NOD 32if NOD32 is installed since it will generate a great amount of log files (.tmp files) with tremendous size to
occupy a lot of hard drive space and cause stop recording.

Do not adjust the system clock after recording is started.

Do not unplug removable disk when system is recording.

Check if any quota limit is set in your hard drive.

Check if the hard drive is set as “read only” or if a folder named “1” exists.

Check if the hard drive is damaged or there are bad sectors inside.

Make sure you do not use network hard drive.

Step 2: If system stops recording which is caused by insufficient hard drive space.

Check the recording paths are the same in FileRecord.ini and Storage location.

Remove the oldest few day video folders or move them to other hard drive.

Check dberr.log (it can be found in D-ViewCam installation folder). If there are a lot of errors of Eventlog and Systemlog in
dberr.log, and Eventlog.mdb and Systemlog.mdb is oversized caused by extremely frequent events or scheduler is set as
record on motion while the cameras focus on a dynamic background.

The space for system hard drive must be more than 800 MB and the space of data hard drive must be more than 500 MB for
Mainconsole to run recording.

If you still experience stop recording, please use DB tools to repair/rebuild database to re-associated recorded video.
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9.Why do | get “Live streaming server can not be connected”? Efror rz|

In general, this error message is caused by network problem so always
check your network connection first.

If you are connecting to a remote server or device through WAN.
Please make sure the remote server or device is not behind a router's
firewall or the port is forwarded properly to bypass the router's firewall.

6 Live streaming server can not be conmected

10. Why do | get “Missing or corrupted resource files. Please re-install the Eirnr r)ﬂ
system to solve the problem”? Lad

Missing or corrupted resource files.
Please re-install the svskem bo sobwe this problem.

This error message occurs when the software failed to execute the
necessary file for the requested operation.

(1) Occur when loading Mainconsole

The skin files or database may be corrupted to cause this error message.
Please uninstall the software, remove D-ViewCam folder in C:\Program Files\ and install the latest version.

(2) Occur when loading ActiveX of web live viewer/ playback

Please follow below instrument for troubleshooting.
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1.) Turn off UAC in control panel on Windows Vista.
2.) Enable the privilege level option in compatibility tab in Mainconsole properties.

11. Why do | get “The procedure entry point WMCreateWriter could not be located in the dynamic link library
WMVCore.DLL.”?

If you met the error message as follows, please upgrade your windows media player and this problem will be fixed.

Live¥iew.exe - Entry Point Mot Found T il

Q The procedure entry poink WhCreatewriter could not be located in the dynamic link library e Core, DLL,

[8].%

Playback.exe - Entry Point Not Found : _ |

0 The procedure entry point WiCreatei'riter could nok be located in the dynamic link library WiihCore,DLL,

21k

Please download the latest Windows media player here, http://www.microsoft.com/windows/windowsmedia/default.mspx
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12. How do | start network services?

Step 1: Go to [General Setting] -> [Network services],
and you will see several services you can use.

Step 2: Please remember to click on [Start] of the
services you want to start in Main Console.

CAM1 D-Link DCS-3714 (172.17.5.76)

B EEREENEEEE,

Setting

SavefLoad Configuration

il Log Viewer

Live
Streaming

Remote
Playback

Main | Black/ White List | Performance |

Client Count 0 | Kill

[ i

State IP Camera

Service
Server Status: Stopped

Bitrate (Kbps)

Start Stop

Drefault

Options
Port: |5150
Maximum Connections: 64
¥ Use Default Web Server
Part: 80
v Save Log |LiveSewer.Iog

v Enable Audio

Il
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13.How to configurd my PC/Server to allow remote access for the viewer

Metwork Service - 169.254_25]_@ z @5.15257 /1608254177204 /169.254.160.148 /1721 ..

and playback?

In order to view remote live viewer and remote playback from the
internet, there are two things you have to do.

Step 1: Start <Network Service> in Mainconsole
Please go to <Main Console> - <Config> - <Network Service> and

then start this service.

Our default port number for live streaming is 5150.
Our default port number for remote playback is 5160.

The default port for web browser is 80.

If you need to change it to another one, please don't forget to set it to

port forwarding on your router.

Main | Black /white List | Performance |

Live Client Count 0o | Kill [ wkman |
Streaming
State IP Camera Bitrate (Kbps)
>
Remote
Playback
Senice
Server Status: Stopped Stop
Options
T | [s150 | Default ] |
Maximum Connections: |ﬁ4

[¥ Use Default Web Server

Port: &0
¥ Save Log |LiveSeNerIﬂg Y

[v Enable Audio

l\/ oK J [x Cancel]

Metwork Service - 169.254_25]_@2 @53{57 /1608254177204 /169.254.160.148 /1721 ..

Main | Black /white List | Performance |

Live User Count 0o | Kil [ wkman |
Streaming

IP User Bitrate (Kbps)

Senvice
Server Status: Stopped Stop
Options
Port | 5160 Defaut ||
Maximum Users: |15

¥ Use Default Web Server

Port: 20
¥ Save Log ‘Remote?\ayback.log =3

l\/ oK J [x Cancel]
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Please notice that if you met the following error message, it means your
port 80 was occupied by the other device, therefore, you have to

change it to another port number. ST R
@ Pleaze check if other application occupied port B0

Step 2: Enable port forwarding in your router
After that, what we have to do is to find the public IP address of your router and set port forwarding on the router to NVR
LAN IP.

* You can see the public IP address of your router in its configuration menu.

* You can also configure NAT (or port forwarding) port 80, 5150 and 5160 to your NVR'’s LAN IP (e.g. 192.168.3.30) in the
router.

* Port forwarding looks something like this in your router:

You have to forward 3 ports, one for 80, one for 5150 and one for 5160.

All 3 ports should point to e.g. 192.168.3.30 o ke _ .
E—} Bluetooth File Transfer Wizard
[Z Calculator
| | e - =
After you have successfully forward the 3 ports in your router, you will be able to @ Connel__| OPe"
access remote live viewer and remote playback from the internet. | Notepd ' Run as administrator
W Paint Open file location
14. Why can't | see live view and video playback on Internet Explorer after up & Remot S e Rt
grading to the latest version? SIRun | = WinRAR ;
=% Snippin
) ) ) E Snupnpd Pin to Start Menu
It is often caused by the old te_mporary I_E components in Windows. Please remove @ SyncC A bk it
the old IE components and reinstall ActiveX to solve the problem. g Welcol
Send To »
. L : : : {8 Windo
Step 1: Closed IE and all of its related applications first. Otherwise some files may R Windo Cut
be locked during removal. If your OS is Vista, please run "Command prompt" as B Windo Copy
administrator first or you will not able to remove the components. ) Wordp
| Easeof Delete
Rename
1 Back | Properties
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Step 2: Go to [Start]->[Run]->key in: cmd and press [OK] Run 7%

Type the name of a program, folder, document, or
Internet resource, and Windows will open & For you.

Open: | omd| w

[ i || Cancel H. Browse. .. |

WINDOWS\system3 2'emd. exe

Step 3: Key in: cd C:\WINDOWS\Downloaded Program Files § yris :
Step 4: Key in: dir to list all objects on this folder and Serein —bounlosded Progran Files

3T NDOY

Step 5: Key in: del /s .

Don't forget the Period (.) after /s

Step 6: Keep pressing Y when prompted to delete all the files
in the folder

der.dll
derHew.dll

you supe
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Step 7: Key in: rmdir /s .
Don’t forget the Period (.) after /s

Step 8: Keep pressing Y when prompted to clear up the

remaining files in the folder

Step 9: Key in: dir and press [Enter] to check if the folder

is empty.

Step 10: Complete. You can now reinstall your ActiveX with

web remote client.

o CAWINDOWSsystem 3 2vem d.axe

IC = SWINDOWS ~Down loaded Program FilesPradir s

15. What ports for network service are used by default?

C:WINDOWS “Down loaded Progran

The default ports can be changed however you like, but we strongly recommend you avoid using ports below 1024 because

they are often used by other system services.

Service

Port

Purpose

Live Streaming

5150

Communication between desktop remote
live viewer and Main Console

Default web Server

80

Access protocol of web based remote client

Remote Playback

5160

Communication between desktop remote
playback and Main Console
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-

16. Can | hear the audio at D-ViewCam remote live viewer "Camera settings
application and Internet Explorer browser?

Set camera stream quality

-
Yes, please right click on the screen and check <Enable Audio>. e e el
» Camera: D-Link DC5-942L (172.17.5.31)
Please do not forget to enable audio at Main Console first. gty
Video Format: " MJPEG " MPEG4 v H2G64

Frame rate: 30 -

Resolution: G40x480 T
Bitrate Mode: Constantbitrate  ~

If you are using IP cameras, please go to <Main Console> - <General
Setting> - <Setting> - <System Setting> - <Camera> - <Camera Settings>

Bitrate: 2048 I
T
Image Adjustment
[~ Enable Flip

[~ Enable Mirror

Audio
v Enable Microphone

|v Enable Speaker
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And also go to <Main Console> - <General Setting> - <Setting> -
<System Setting> - <General> - <Audio Preview>

Startup
™ Main Console

I™ Schedule Recording System

™ Sman Guard System

™ Live Streaming Server

™ Remote Playback Server

™ Full Screen

I™ Auto Lock System

™ Auto Login Setup

Miscellaneous
I™ Automatically popup event report

[ Minimize to system tray

[~ Synchronize video frames

General |Camera\ 1O Device | PTZ Config | Hotline | Address Book | Menitor Display |

Storage
Location ExEE)

C:\Program Files (x86)\D-Link\D-ViewCam

Recycle Setup:

Video Recydling |

Status Display
W Current Date
[ Current Time I
W Login User

¥ Frea Disk Space

[~ IP Camera Bitrate
[~ User Defined Text 1

—

[~ User Defined Text 2

( Log Regycling |

Audio Preview

Default Channel (NotUsed) -

[ Enable Audio on Aclive Channel

Volume J—

Auto Reboot
I Enable Auto Reboot
Every m

(soment |
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17.Why my IE8 doesn’t work well with D-ViewCam software ?

/7 Remote Live View - Windows Internet Explorer

§.\— * bd \g, hitp:f192.168 43281 iveview-himlshinive View hinl

WA | Remot Live View |

/= Yahao! - Windows Internet Fxplorer

b Departrrent_1
I DCS-5300G_1

ﬁ—j w8 Dthp v wahoo,com! - E | % !#" v Saarch | 2 -
-Hle E.dl: Wigw Fa\'mtssm “Help i
In order to install ActiveX under IE 8 environment, we need to setup [ ramie s @ feResommrsan. i
fo”owing SettingS. :aymmg [ Feopen Lest Browsing Sesson ® v Fager Sefeby « Tk - - i
. . | i (=] th-Shif L+ ]
Generally, there are two settings to make it work. | rememrtarasne | oo worews  wome £
!:irst of all, please make sure ‘vcredist_x86.exe’ has already been YAHO( il
installed. | Ameshas oy
iy TENO0!  MEES YIVOUrNOME  Compabbiby Yiew slanin - e
| Cnr|:|.mti:|il:y. ‘iiu-u E:tln;
Step 1: Add the Server IP into Trusted Web Site. MELavOaTES & s
View Yanoot Ses | S S 5 A:;’:;
Yahoo! Mal | Doveloger rads Flz 3. Mich:
(=" = Windows Mess=nger 4 US
a e Dlagmgacnrn:jlmmhlm... 5 MDA
[i Facebook —
E Finance (Dow Jonss _J ; e :l::::llul
B Games Most stressful cities in America -
& ! *
Enahles vau to chenps setings, ar Wiorew -
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General | Security |F‘riv.-'ar.3|I | Content I Connections I Programs | ndvan::ed|

You can add and remove websites from this zone. all websites in
this zone will use the zone's security settings.

® Add this website to the zone:

Select a zone to view or change security settings.

Internet  Localintranetl Trusted sites § Restricted
sites
Trusted sites ; = Ebsﬂ:es: ;
This zone contains websites that you — http://192. 188, 1. 100 | Remove
trust not to damage your computer or
your files,

You have websites in this zone.

Security level for this zone

Allowed levels for this zone: Al

[] Require server verification (https:) for all sites in this zone

Low
- Minimal safeguards and warning prompts are provided
- Most content is downloaded and run without prompts
- All active content can run
= - Appropriate for sites that you absolutely frust

[]Enable Protected Mode {requires restarting Internet Explorer)
l Custom level. .. ] l Default level ]

’ Reset all zones to default level ]

Coc ) Lo ][ sy
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General | Security |Pri1.rar.y I Content I Connections I Programs | ﬁduaﬂr.:edl

|&® \NET Framework
Select a zone to view or change security settings. ._ﬁ Loose XAML

() Disable
@ &« v O
y . X () Prompt
Internet  Localintranet QEECEETEE — Restricted £
_ it ,_ﬁ ¥AML browser applications
() Disable
@ Enable

Trusted sites

This zone contains websites that you @) Prompt
trust not to damage your computer or o =5
your files, [#= XPS documents
You have wehsites in this zone. () Disable
@ Enable
) Prompt
B NET Framework-reliant components
Low % Permissions for components with manifests
- Minimal safeguards and warning prompts are provided B Micahda
- Mozt content is downloaded and run without prompts 1| 1 |

- All active content can run
- Appropriate for sites that you absolutely trust *Takes effect after you restart Internet Explorer

Security level for this zone

Allowed levels for this zone; All

=

Reset custom settings
[T|Enable protected Mode (requires restarting Internet Explorer) -

Reset to:
[ Custom level,., ]’ Default level l fese 'i_uw l: ' Reset,.. l
=

[ Reset all zones to default level

ok || cancel
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Step 2: Add the Server IP Compatibility View Setting

/= Yahoo! - Windows (nternet Fxplorer

@__ :_,--'r |#I'- v yehoo. com) SalR= ke 1 |;J_.'
Rk LEdE Vi Faaris H:lp
” i |1 c Dielete Brovesing Hstory. . Chrl+Shift+Del
JrFavoites |5 oo
i Favorites | oy 5. TnFrivate Browsing Chil+Shit+F
i vahool REapen Lagk Eromsng Sessin B = paga- saaty- Toos- @
I InPrivate Fiterng CHH R =
TnPriwate Fikering Setbings LOCAL SHOPPING ORI
HOC 2 'l
A 0 SmartSeresn Fiker J
Manage= Add-ans =
WMy Yahoo! Mak= ! your homef CEIM“ i\lhw Sign In
MY FAVORITES Ml o e b s e POFU —
- . ez DEconery b 1 Kz
View Yahoo! Sites windaws Update &
Yahoo! Mail Dieweloper Taaks Fi2 I M
E AUtos “Windaws Messenaar d. L
Diagnoae Connechion Problems. 5 M
[i ke Tntermiet Options ;
m Finance (Dow Jones 4f] =l o & : Yahc
E Games Most stressful cities in America
= Congestion, unemployment, and sinking = Stay happy in tough fimes
Wl HotJobs home values create high anxiety far Oy Srreas relef ot work
— rapidants hats Lt s 5 Wik ik vifinm |
i i | L]
faor WMol -

Compatibility View Settings

l/_vlsl ¥ou can add and remove websites ko be displaved in
& Compatibility Wiew,

Add this website:
| |

Websites vou've added to Cormpatibility View:

add

192,168,1.100

[ ]1nchude updated website lists From Microsoft
Display inkranet sites in Compatibilicy Yiew
[ oisplay all websites in Compatibility Yiews

Remave

Close
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Open Microsoft’s Internet Explorer browser and input the D-ViewCam server’s IP address with port number (e.g. http://127.0.0.1:80) to connect
to D-ViewCam server.

Remote Live Viewer
e

(53

fﬁ Please enter user name and password for live semnver
L

Login

Senver 127.0.01

User Name ||

Password |

Cancel

$ulding Networks for Pecpie

9000000 »

CIEESE | 2 |
EEEN =
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Enjoy 3.2 web live viewer with Internet Explorer 8.

Step 3: (Optional) If the instructions above doesn't work, please try the following method.

/= ¥ahao! - Windows Internst Fxplorer

C6- -

1w wahoocom! - E *"r L !5_‘ e Saach
Fle Edi  Wiew Faworites a Help
; | DebkteBrowsing Heary... trh-SHFt+Del
¢ Favorie SoF uoged
?‘f mitze: | Mgl | InPrhaa Browsng Ctrh-sHft+HP
| i vzhea | Renpen Lest Browsing Sessicn M - Pager Sdetpr Tk g
IrPrivae Filtering ctrh-shift+F ]l
IrPrhana Fltennad sattngs LOCAL SHOPPING MORE [
c Fop-up Blocker F
AHO .  Smart3creen Fker 3
| Manage Add-cns
iy YaNoD | MaEs ¥:your nomed Compatibilty Yiew slanin - Ne
I dc ity Vima Settings
MY FAVORITES L {6 b i Baad, POPULAF
| Foed Dispawery 1. Katy
Lol View Yahoo! Stes
. Mrdms.u-pdd! 2 Andy
Yahoo! Mail Developer Tads Flz 5 Mk
E Aulos Windoaus Mess=nge 4 US
Ciagrioga Carnection Probiems.., 5 MDA
[i Facebook e
rozrnet Optons
ﬂ Finence (Dow Jonae ) ! Yahoo! |
w = e " Find exciu:
@l Games Most stressful cities in America N
A l *
Enabibes wau toochenge setings, ® 10 -

oo

Internet Options

| General | Security | Privacy '| Content | Connections || Programs | Advanced l

Settings

[] oo not save encrypted pages ta disk A
[] Empty Temporary Inkernet Files Folder when browser is clc
Enable DOM Skorage

MR Enble memory protection bo help mitigate online atta

[¥] able Tiatlve 2 F Lo
Enable SmartScreen Filker
[] usessLz.o

Use 551 3.0

Use TLS 1.0

Warn about certificate address mismatch®

[] warn if changing between secure and not secure mode

Warn iF POST subrittal is redirected bo & zore that doss |
|

¢ - | 3
*Takes effect after vou restart Internet Explorer

Restore advanced settings

¥ou should anly use this if vour browser is in an unusable skate.,

Reset Internet Explorer settings —

Resets Internet Explorer's settings to their default
condition.
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18. What is the version of my software?

In [Main Console] -> [General Setting] -> [About Main Console...]

D-Link D-ViewCam 4.0.2 < OK

fg' © 2004-2015
7 D-Link All rights resened.
hitpfwewrs dlmk com!
Product Information
Setting r Model Type:  DCS-100
i Device Pack Version: 2.0.3
Save/Load Configuration y e
IP Camera License Number. 32
B Log Viewer
B Backup
| Network Service FirstAdapter MAC:  10-1F-af-3e-ec-10
| Second Adapter MAC:
| About Main Console... |

19. How do | get the Windows system log and application

log? R A Mk

v B 6o
System log e R B O W
Step 1: Go to [Desktop] -> right click on P o ARARR B, Mem AR
[My Computer] -> [Manage] =B 9 s w = Bl 8 = &
Step 2: In [Computer Management] -> go to L A e
[System Tools] -> [Event Viewer] -> [System] - f:] e
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Step 3: Right click on [System]->[Save Log File As...]

Step 4: Type "system" as file name and save as .evt format
Please name the file as "system" so we know that it is a system

log file

Blre s Ve ek e

- hE FRR &

B e [ T | somarca | Categeey | Event | umar Compter |
IR0 aATATPM Applcatan Mg s i WA rdrny
1641 e AR Appk s My vl i A Sy
WIN IR Appkeabn g tiorm o s
IINIE .. Applcstn Mg Viore oo e
IWiNRE R Sl My (] e ey
IINT008 IR Apphoston g (s o g ]
IINTE SR SsctyCants tiors L e
L ] o | L e
I SREAPN  Ghoe Lbsdate i m =% free
1GNNS SIITPM SecuryCenie Hora - ]
YIS SIRARN  wE torm i ) .
(LA LE BRIARPM G Ul g m = s
I PRISER  Googe Lndate Vorw = = ey
I | EIARE  Googe Undats Yorm - = e
[ 124 P e Ugaate b L . Sedaty
100 LAY Secrtylants et LI Sy
IO (AT W vorm 1 L e
I (ORP Gags Lndats Lre L 5 b ]
I LSORATI kot e ] e waany
I 11ATE. Seeepets Yorw L E]
(LT RE = =] tiore I NA ]
W WA A Cafi it m Lo St
I Remiiad Secotpleis tore - ]
RO RERJAAM CE Ve ! W ]
1 Tien s g e i tora = Tty
1T i ik L] w L] Sy
1T IO Appkation Harg (e e ]
L TR tors: =n o ]
I e 1 it gl on T Sy
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Application log

Step 1: Go to [Desktop]-> right click on [My Computer]->

[Manage]

Step 2: In [Computer Management]-> go to [System

Tools]->[Event Viewer]->[Application]

Step 3: Right click on [Application]->[Save Log File As...]
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Step 4: Type "application" as file name and save file with .evt
format

Please name the file as "application" so we know that it is a
application log file

20. How many user accounts can | create?

You can create an unlimited number of user accounts.

21. How do | setup local area network or LAN?

D-ViewCam supports both LAN and WAN. If your surveillance
system does not need to have internet access, you can setup a
private network or LAN to establish networking between
Mainconsole and other network devices such as IP camera.

Setup with static IP
Step 1: Go to [Control Panel]->[Network Connections]

Save "System” As

Savein: | ) My Documents “l OB
My Music
_b My pictures
My Recent )My Received Files
Documents
Deskiop
My Docusments
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q File name: | system v I Save
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Step 2: Right click on [Local Area Connection]->[Properties]

Step 3: Select [Internet Protocol(TCP/IP)]->[Properties]
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Step 4: Select [Use the following IP address:] and fill the fields as shown in

the picture

[192.168.1.1] and [192.168.1.254] is normally occupied by the router or other

network devices, so please try to avoid using these |IP addresses.

Please note that you will only be able to access IP address between the same
subnet address, such as [192.168.1.1 to 192.168.1.254]

Setup with dynamic IP

We strongly discourage the assigning dynamic IP address to IP cameras which
is based on DHCP. The IP address of each IP cameras is temporary so
whenever the address is reassigned, the camera will lose connection
permanently to your D-ViewCam server unless you manually rematch the
camera's new IP address to D-ViewCam server.

22. Camera Connection

Internet Protocol (TCP/IP) Properties

General
You can gel IP seltings assigned automatically if your network, supports

this capability. Dtherwize, you need o ask pour network sdministrator for
the appropriate IP settings.

() Obtain an IP address automatically

(®) Uge the following IP address:
|P address: 192 .168 . 1 10

Subnet mask: 255.255.255. 0
Default gateway

(®) Use the following DNS server addresses
Prefered DNS server.

Alernate DNS server

D-ViewCam supports both LAN and WAN. If your surveillance system does not need to have internet access, you can setup
a private network or LAN to establish networking between Mainconsole and other network devices such as IP camera.
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Open Source Software Notification

D-ViewCam V3.x and V4.x products makes use of the following software licensed under LGPL (Lesser General Public License).
You can download the copies of the LGPL licensed software from the official web site listed as the following.

1.1 LIVE555 Streaming Media (www.live555.com/liveMedia/, GPL v2)
© 1991, 1999 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone is permitted
to copy and distribute verbatim copies of this license document, but changing it is not allowed.

1.2 ffmpeg v51.46.0 (www.ffmpeg.org, GPL v2)
© 1991, 1999 Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone is permitted
to copy and distribute verbatim copies of this license document, but changing it is not allowed.

1.3 FAAC v20020104 (sourceforge.net/projects/faac, GPL v2)
© 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to copy
and distribute verbatim copies of this license document, but changing it is not allowed.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright
holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called
“this License”). Each licensee is addressed as “you”.

A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application
programs (which use some of those functions and data) to form executables.

The“Library”, below, refers to any such software library or work which has been distributed under these terms. A“work based
on the Library” means either the Library or any derivative work under copyright law: that is to say, a work containing the
Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language.
(Hereinafter, translation is included without limitation in the term “modification”)
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“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source
code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used
to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The
act of running a program using the Library is not restricted, and output from such a program is covered only if its contents
constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true
depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library’s complete source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of
warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this
License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in
exchange for a fee.

2.You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any
change.

¢) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that
uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort
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to ensure that, in the event an application does not supply such function or table, the facility still operates, and performs
whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any application-supplied function or table used by this function must be
optional: if the application does not supply it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the
Library, and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do
not apply to those sections when you distribute them as separate works. But when you distribute the same sections as part
of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose
permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent
is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library)
on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the
Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public
License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License has
appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies
to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable
form under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-
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readable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used
for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to
copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties
are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being
compiled or linked with it, is called a “work that uses the Library”. Such a work, in isolation, is not a derivative work of the
Library, and therefore falls outside the scope of this License.

However, linking a“work that uses the Library” with the Library creates an executable that is a derivative of the Library (because
it contains portions of the Library), rather than a “work that uses the library”. The executable is therefore covered by this
License. Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work
may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the
work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined
by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline
functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section
6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to
produce a work containing portions of the Library, and distribute that work under terms of your choice, provided that the
terms permit modification of the work for the customer’s own use and reverse engineering for debugging such modifications.
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You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are
covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you
must include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this
License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable
linked with the Library, with the complete machine-readable “work that uses the Library’, as object code and/or source
code, so that the user can modify the Library and then relink to produce a modified executable containing the modified
Library. (It is understood that the user who changes the contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run
time a copy of the library already present on the user’s computer system, rather than copying library functions into the
executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the
modified version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy
the above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the“work that uses the Library”must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything
that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.
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It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an
executable that you distribute.

7.You may place library facilities that are a work based on the Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the
work based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights, from you under this License will not have
their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to
modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License.
Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license
from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not
impose any further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties with this License.

11.1f, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent
issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of
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this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the
Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who
receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is
intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity
of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which
is implemented by public license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if
he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12.If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time
to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or
concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies
to it and “any later version’, you have the option of following the terms and conditions either of that version or of any later
version published by the Free Software Foundation. If the Library does not specify a license version number, you may choose
any version ever published by the Free Software Foundation.
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14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible
with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write
to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of
preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT
PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE LIBRARY “AS IS"WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR
ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
OR LOSSES SUSTAINED BY YOU ORTHIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2. Expat XML parser v2.0.1 (expat.sourceforge.net)
© 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper
© 2001, 2002, 2003, 2004, 2005, 2006 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

3. OpenSSL v0.9.8.g (www.openssl.org)
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original SSLeay license
apply to the toolkit. See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses.

© 1998-2007 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2.Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)”

4.The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products derived from this
software without prior written permission. For written permission, please contact penssl-core@openssl.org.

5. Products derived from this software may not be called “OpenSSL’ nor may “OpenSSL” appear in their names without prior
written permission of the OpenSSL Project.

D-Link D-ViewCam User Manual 164



Appendix A - Open Source Software Notification

6. Redistributions of any form whatsoever must retain the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ""AS IS"AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, ORTORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

4. Crypto++ v5.5.2 (www.cryptopp.com)

© 1995-2006 by Wei Dai. All rights reserved.

This copyright applies only to this software distribution package as a compilation, and does not imply a copyright on any
particular file in the package.

The following files are copyrighted by their respective original authors, and their use is subject to additional licenses included
in these files.

mars.cpp - Copyright 1998 Brian Gladman.

All other files in this compilation are placed in the public domain by Wei Dai and other contributors.
| would like to thank the following authors for placing their works into the public domain:

Joan Daemen - 3way.cpp

Leonard Janke - cast.cpp, seal.cpp

Steve Reid - cast.cpp

Phil Karn - des.cpp
Michael Paul Johnson - diamond.cpp
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Andrew M. Kuchling - md2.cpp, md4.cpp

Colin Plumb - md5.cpp, md5mac.cpp

Seal Woods - rc6.cpp

Chris Morgan - rijndael.cpp

Paulo Baretto - rijndael.cpp, skipjack.cpp, square.cpp

Richard De Moliner - safer.cpp

Matthew Skala - twofish.cpp

Kevin Springle - camellia.cpp, shacal2.cpp, ttmac.cpp, whrlpool.cpp, ripemd.cpp

Permission to use, copy, modify, and distribute this compilation for any purpose, including commercial applications, is hereby
granted without fee, subject to the following restrictions:

1. Any copy or modification of this compilation in any form, except in object code form as part of an application software,
must include the above copyright notice and this license.

2. Users of this software agree that any modification or extension they provide to Wei Dai will be considered public domain
and not copyrighted unless it includes an explicit copyright notice.

3. Wei Dai makes no warranty or representation that the operation of the software in this compilation will be error-free, and
Wei Dai is under no obligation to provide any services, by way of maintenance, update, or otherwise. THE SOFTWARE AND
ANY DOCUMENTATION ARE PROVIDED “AS IS"WITHOUT EXPRESS OR IMPLIED WARRANTY INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL WEI DAI OR
ANY OTHER CONTRIBUTOR BE LIABLE FOR DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

4. Users will not use Wei Dai or any other contributor’s name in any publicity or advertising, without prior written consent in
each case.

5. Export of this software from the United States may require a specific license from the United States Government. It is the
responsibility of any person or organization contemplating export to obtain such a license before exporting.
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6. Certain parts of this software may be protected by patents. It is the users’ responsibility to obtain the appropriate licenses
before using those parts.

If this compilation is used in object code form in an application software, acknowledgement of the author is not required but

would be appreciated. The contribution of any useful modifications or extensions to Wei Dai is not required but would also
be appreciated.
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